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Overview: 

 
Under the Banner computer system, there are no automatically-generated 
monthly budget reports sent to departments. It is important to monitor 
transactions to ensure that information is posted accurately. Banner allows 
instant access to budget information on line.  The information contained in this 
training session will assist you in monitoring your budget information in Banner 
and discuss the budget tools available to you.  Departments are responsible for 
ensuring that budgets are monitored and that any negative variances are 
resolved timely.  Departments should reconcile budgets at least monthly.    

 

Objectives: 

 

# What every Budget Unit Director should know about monitoring budgets 

 (including Accrual Accounting, fund/ledger differences, Banner Finance 
access, master signature list, designating a budget unit director, and 
forecasting) 

 

# Budget Unit Director (BUD) Responsibilities 

 

# Budget Increases 

 

# Budget Adjustments 

 

# Guidelines  

Personal Services 
Overtime 
Equipment 
Work Study 
Gift Management 
Fringe Benefits 
Fund Transfers 

 

# What Banner forms to use to monitor budgets 

 

# Transaction Types in Banner 

 

# How to perform research 

 

# About downloading select information into Excel 

 

# About Insight Budget Reporting 

 

# Printing Budget Reports with ePrint 
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# How to report errors or request more detailed research  

 
Terms and Definitions  
 

# Auxiliary Services - Activities within the University, which furnish a service 

directly or indirectly to students and faculty, are considered auxiliary services.  
These activities charge fees directly related to, but not necessarily equal to, the 
cost of service. The public may also be served indirectly by some auxiliary 
services.  These services are essential support elements of the institution’s 
program and are considered self-supporting. 

 

# Budget Adjustment - When funds must be transferred from one budget to 

another, a budget adjustment form must be completed, signed by the budget 
unit director, and forwarded to the Budget Office for processing.  This form must 
also be completed when moving funds from a "locked" line item (i.e., salaries, 
overtime) to another line item or pool account.  Generally, funds are moved from 
pool account to pool account unless they fall into the "locked" (line item 
budgeted) category. 

 

# Budget, Base – The annual budget commitment for ongoing operations of a 

department or area.  Represents the “base” commitment of resources for 
operations.  The base is not designed to fund special projects and/or temporary 
shifts in operating expenditures.  The base budget may be modified during the 
course of an operating budget year and/or during the budget development 
process. 

 

# Budget, Operating (OPAL) – The annual operating budgets of a department or 

area.  The operating budget includes base funding as well as one-time funding 
for special projects and/or temporary shifts in operating expenditures.  Budget 
units may shift funds within their operating budget to align resources with specific 
needs in a given year. 

 

# Budget Prep - Each year, budget unit directors are required to put together an 

estimate of projected expenditures (including justification for increases or 
decreases) for the following fiscal year.  The process of preparing the budget 
materials and submitting them for approval or modification is referred to as 
budget prep. 

 

# Deposit - The term used to describe funds being put into a budget. 

 

# E&G - Education and General (E&G) funds are made up of two allocations called 

general and nongeneral.  The general funds are tax revenues collected by the 
State and appropriated to the University as our share of all tax revenues.  The 
nongeneral funds are the tuition charges paid by students. 
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# Encumbrance - When a purchase order is issued, the funds for the purchase 

must be reserved.  The process of reserving the funds is referred to as 
encumbrance. Once funds are encumbered, they are removed from the balance 
available.  This prevents over-expenditures from occurring and allows 
departments to monitor available budget balances. 

 

# Expenditures - Refers to the actual funds expended.  When a vendor bill is paid, 

it becomes an expenditure. 
 

# Equipment Trust Fund (ETF) - The Higher Education Equipment Trust Fund 

(HEETF) was established in 1986 by the General Assembly to provide funding to 
upgrade equipment needed for instruction and research.  The State Council of 
Higher Education for Virginia (SCHEV) shares administrative responsibility for 
the program with the Virginia College Building Authority (VCBA) and the 
Department of Treasury. 

 

# Fiscal Year - The University's fiscal year runs from July 1 through June 30. 

 

# Funds / Fund Balance – A Fund is a self-balancing set of accounts, segregated 

for specific purposes in accordance with laws and regulations or special 
restrictions and limitations.  The Fund Balance is the residual balance of 
Revenues less Expenses of the accounts maintained within the fund. 

 

# Indirect Costs – Auxiliary Enterprises units are required by the State to pay for 

the indirect costs of services received from E&G activities. 
 

# Insufficient Funds - Prior to a purchase order being issued to a vendor, the 

funds must be encumbered.  If funds in the budget are not adequate to cover the 
expected expenditure, this lack is referred to as insufficient funds.  Funds must 
be available for all expenditures no matter the method of expenditure (PCard, 
travel reimbursement, wage/student expenses, etc.) 

 

# Interdepartmental Transfer - When funds must be transferred between budgets 

at the University, an Interdepartmental Transfer Request (IDT) form must be 
completed and signed by both budget units affected.  The IDT form is forwarded 
to the Office of Finance for processing.  Transfers can be effected for the 
following reasons:  to reimburse a department for expenditures, to pay for 
services rendered, or to correct an original charge from one budget to another. 

 

# Journal Entry - This term refers to the actual computer entry to move revenues 

or expenditures from one department to another via an IDT (Interdepartmental 
Transfer). 

 

# Line Item Budgeting - Certain expenditure items (for example, classified 

salaries, wages, overtime) are budgeted at the line item.  Funds in these line 
items may be moved via budget adjustment only. 
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# Liquidation - After a purchase order is complete, the vendor bill is paid.  If the 

amount expended is less than the original amount encumbered, it is possible 
some funds will remain encumbered. The process of releasing those funds is 
referred to as liquidation.  Liquidation requests are handled by Procurement 
Services. 

 

# NPS (Nonpersonal Services) – Contractual services, supplies and materials – 

made up of the sub-accounts in the 5000 and 6000 series. 
 

# ODS (Operational Data Store) - This is the product used for budget reporting 

using Insight.  ODS is created using data from Banner.  Reports are accessed 
via Insight. 
 

# One-Time (Revenues/Expenditures) – These are revenues or expenditures 

that are not recurring in nature and are specific to a given fiscal year or other 
short-time cycle.  One-time funding may be approved in the budget process for a 
specific project or other program/purpose.  This funding does not become part of 
the department’s base funding and is not included in the following year’s 
beginning budget. 

 

# Org Code - The terms "budget code" and "organization (org) code" are 

synonymous.  They represent the five digit code used to identify the department 
for financial transactions (i.e., 1CL00 is the budget code for the Office of 
Finance). 

 

# Pool Budgeting - Refers to the items within the budget that are not "locked" into 

specific line item categories.  Generally benefits, non-personal services, travel, 
and equipment use the pool budgeting method. (Benefits, 4999; NPS, 6999; 
Travel, 7999; Equipment, 9899). 

 

# Recovery refers to a special kind of budget used to recover funds expended by a 

service-oriented unit in the performance of approved activities.  Recovery 
budgets may expend only funds for which they can charge-back other 
departments.  For example, telephones are charged to departments as a 
recovery. 

 
If funds being deposited are for recovery of services, they must be deposited to 
the appropriate recovery account.  Recovery accounts can be either intra-agency 
recovery (recoveries from within the University) or inter-agency recovery (outside 
the University, but within the state). 

 

# Revenues are funds paid to the University for services or for donations.  

Revenues are recorded in the period in which they are earned, regardless of 
when the payment is actually received. 
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# SCHEV Established in 1956, The State Council of Higher Education for Virginia 

(SCHEV) is the Commonwealth's coordinating body for higher education.  Their 
mission is "to promote the development of an educationally and economically 
sound, vigorous, progressive, and coordinated system of higher education" in 
Virginia. 

 

# Service Units are areas that provide specific types of services to the University 

community as a regular course of business.  Examples of service units include 
Dining Services, telephones, and Facilities Management. 

 

# Sub-Object Code -  The sub-object code is for use in identifying a category of 

expense or transfer payment in the budget process and for coding purchase 
requisitions, purchase orders, travel documents, etc. 

 

# Transfers - The act of moving money from one fund to another.  Fund transfers 

are accounting transactions that move cash from one fund to another and are 
classified as mandatory (arising from binding legal agreements) and non-
mandatory (agency discretion). 

 

# Vendor Number - All vendors doing business with Old Dominion University are 

identified by their Federal Employer Identification Number (FEIN) or, in the case 
of sole proprietorships, the University Identification Number (UIN).  The 
University is required to have an IRS form W-9 (Request for Taxpayer 
Identification) or W-8BEN (international vendors/individuals) or an acceptable 
substitute on file for each vendor receiving payments from the University.  No 
purchase orders or checks may be issued to vendors until Accounts Payable has 
this information on file.  Departments are responsible for obtaining either the W-9 
or the W-8BEN for new vendors.  Please refer to Payment for Goods and 
Services for more information about vendor numbers and Independent 
Contractor payments. 

 

# Vouchers – Every expenditure made by the University has payment 

documentation (referred to as a voucher) for record-keeping purposes.  A 
voucher may contain payment for more than one expenditure/invoice. 
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Fund/Ledger Information  
 
Funds are utilized in Banner to manage and account for funding that is segregated for 
specific purposes in accordance with laws and regulations or special restrictions and 
limitations.  Funds are further grouped by common designations and/or purposes and 
financial reporting requirements into what are referred to as Ledgers.   
 
The table below highlights the common ledgers/fund groupings utilized by the 
University: 

 

 

 
Organization Codes, or Budget Units as they are often called, are utilized to record 
budget and financial transactions in Banner and represent the lowest level of the 
fund/ledger structure.  Organization Codes are utilized in eVA, Banner and many other 
University systems to transact business.  Organization Codes are all affiliated with a 
specific fund; however an individual fund may have more than one Organization Code 
affiliated with it.  Using the Club and Rec Sports Fund from the table above as an 
example, you can see that there are multiple individual Organization Codes affiliated 
with this fund.  
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025648 CLUB & REC SPORTS 4AT87 SPORT CLUBS

025648 CLUB & REC SPORTS 4AT88 INTRAMURAL/EXTRAMURAL PROGRAM

025648 CLUB & REC SPORTS 4AT89 OUTDOOR ADVENTURE PROGRAM

025648 CLUB & REC SPORTS 4AT90 FITNESS & WELLNESS

025648 CLUB & REC SPORTS 4AT91 REC & WELLNESS FACILITY OPERATIONS

025648 CLUB & REC SPORTS 4AT94 RECREATION & OPERATIONS

025648 CLUB & REC SPORTS 4AT95 REC SPORTS SUMMER CAMPS

FUND_CODE ORG_CODE

 

Notice that all of the Organization Codes in this example begin with a “4”.  This simple 
approach to assigning organization codes makes it easy to identify which of the ledger 
groups a budget unit is associated with (4 = Local Auxiliary Services).  A few additional 
examples are provided below: 
 

LEDGER

1 011000 STATE E&G FUND SUB-GROUP 011001 C/W E&G CUR 1PN00 BUDGET OFFICE

1 011000 STATE E&G FUND SUB-GROUP 011003 C/W CEPS FUND 1AL18 COMMUNITY DANCE PROGRAM

2 015000 LOCAL EDUC & GEN FUNDS 015007 INT'L PROGRAM DEVELOPMENT 2IN05 INT'L PROGRAM DEVELOPMENT

3 021000 COMMONWEALTH AUXILIARY ENTERPRISES 021301 RESIDENTIAL HOUSING 3HS00 STUDENT HOUSING

4 025000 LOCAL AUXILIARY ENT. 025601 INTERCOLLEGIATE ATHLETICS 4AT00 ATHLETICS

5 031000 FEDERAL GRANTS & CONT 031190 CHES BAY PLANKTON MONITORING 5BLG5 CHES BAY PLANKTON MONITORING

6 043000 GIFTS DEPT - GENERAL 043152 F. LUDWIG DIEHN CONCERT SERIES 6AL07 F. LUDWIG DIEHN CONCERT SERIES

7 071000 C/W UNEXPENDED PLANT 071148 SYSTEMS RESEARCH BLDG 17678-0965 71900 SYSTEMS RESEARCH BLDG 17678-0965

8 046000 GIFTS-SCHOLARSHIPS/FELLOW 046364 MANSBACH DOMINION SCHOLAR 8SXF1 MANSBACH DOMINION SCHOLAR

A 082000 ASSOCIATIONS 082041 MID ATLANTIC BANNER USERS GROUP A0037 MID ATLANTIC BANNER USER'S GROUP

FUNDCODE BUDGET CODEFUND GROUP

 

 
Fund Restrictions 
 

 Restricted funds may only be expended for the purposes indicated by the donor 
or grantor: includes gifts, grants, contracts, and financial aid, ledgers 5, 6, and 8.  
In the case of ledger 6 gift accounts, the Educational Foundation is responsible 
for maintaining complete records on restrictions.  

 

o If the grant or contract is “silent” on allowable expenditures, 
the CAPP Manual rules apply. 

 

 Unrestricted funds are available for current operations at the discretion of the 
University within allowable guidelines: includes Educational and General Funds 
(E&G) and Auxiliary funds, ledgers 1, 2, 3, and 4.   

 
o Unrestricted does NOT mean uncontrolled, as CAPP Manual rules 

and University policy apply. 
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Organizational Hierarchy 
 
The University leverages an organization code hierarchy in Banner to facilitate budget 
management and reporting in a manner that replicates the organizational structure of 
the University.  There are five layers to the organization code hierarchy: 
 

1. University 
2. Vice Presidential Area 
3. College of Division 
4. Department or Office 
5. Budget Code 

 
The table below provides a few examples of this structure: 
 
University Vice Presidential Area College / Division Department / Office Budget Code

00000 00200 - Academic Affairs 21000 - Arts & Letters XAR00 - Art Department 1AR00 - Art

00000 00200 - Academic Affairs 21000 - Arts & Letters XAR00 - Art Department 6AR04 - Art Department Gifts

00000 00200 - Academic Affairs 21000 - Arts & Letters XEH00 - English Department 1EH00 - English

00000 00200 - Academic Affairs 21000 - Arts & Letters XEH00 - English Department 1EH05 - Writing Tutorial Services

00000 00300 - VP SEES 32000 - Enrollment Management XAD00 - Enrollment Management 1AD00 - Undergraduate Admissions

00000 00300 - VP SEES 32000 - Enrollment Management XRC00 - Registrar 1RC00 - Registrar  

 
Several Banner inquiry forms, workflow/approvals, and all of the new Insight Reports 
utilize this organizational hierarchy to facilitate budget management and financial 
reporting. 
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Accrual Accounting 
 
A. Accrual accounting means that revenues are recorded when they are earned, 

and/or the expenses are recorded when they are incurred.  The date that goods 
and services are received determines the fiscal year in which the expenditure is 
recorded.   

 

# Items received on or before June 30 - charged to current FY 

 

# Items received on or after July 1 - charged to new FY 

 

B. Although the University=s fiscal year closes on June 30, we must assure that all 

bills for goods and services received by June 30 are paid.  We will also make 
corrections to expenditures that are incorrectly posted.  This "13th" month will 
generally extend into late July (check the Year-End Closing Calendar for actual 
dates).  During this time, the financial records will be adjusted to reflect all 
revenue receivables as of June 30 and all expenditures payable from the old 
fiscal year.  Payables and expenditures will be posted to all budgets by mid-July 
to allow adequate time for budget review so that errors can be reported and 
corrected prior to the final year-end close.  Revenue allocation adjustments 
between realized and deferred revenue will be allowed between July 30 and final 
close. 

 
C. Budget information for both fiscal years should be monitored carefully during the 

accrual period (July) to ensure that expenditures are recorded in the correct fiscal 
year.  Any errors detected should be reported immediately via an Accounting 
Service Request or Interdepartmental Transfer (IDT) whichever applies (see 
Error Correction Process section).  Refer to the Year-End Closing Schedule for 
the deadlines to submit corrections via Accounting Services Request or IDT. 

 
D. Budgets should be monitored by the budget unit director and reconciled at least 

monthly through the June 30 year-end to assure that budgets are not in deficit.  
Deficits must be resolved.  Actual expenditures and your approved budget 
must be in synch so that your department does not receive a year-end budget 
variance report.  The Budget Office sends periodic Budget Variance Reports to 
the President and Vice Presidents and to Budget Unit Directors. 

 
E. Departments are responsible for making sure that all invoices are paid.  Accounts 

Payable can only pay invoices if a department has completed the e-receiver in 
Banner authorizing payment and the vendor has submitted an invoice.   
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BUDGET MANAGEMENT (minding the store) 
 

After the base budget is developed, approved, loaded into the budget system, and 
interfaced with the Banner Finance System to become the current operating budget, it 
cannot remain static.  It will need to be changed and monitored as plans change or 
programs are added or deleted.  In order to allow for these changes, there are 
procedures for adjusting the budget and guidelines for managing the budget.  The rest 
of this guide addresses these elements. 
 
Establishing a New Budget 
 
Typically, a new organizational budgetary unit (Org) should be requested or will be 
determined to be necessary during the budget development process.  However, as new 
grants are received during the course of the year, and/or as organizational changes and 
programs are implemented, new organizational budget units are also established 
outside of the budget development process.    
 
The appropriate Banner access must be requested when a new budget is created 
– refer to the section Requesting Banner Finance Access. 
 
The form and associated instructions utilized to request a new budgetary unit are 
available at:  http://www.odu.edu/facultystaff/university-business/budget/development/forms  

 
The request form entails: 

 Indicating the appropriate classification (Ledger) 

 The nature and frequency of funding to be received 

 The nature and purpose of the expenditures to be incurred and any restrictions 
that may be made on the use of funds 

 The length of time the org will be valid 

 Identifying the Budget Unit Director for the Org 

 Establishing whom will have signature authority for the Org 
 
The request form must be approved by 

 Grants Accounting 

 Associated Dean/Director 

 Associated Vice President (or Designee) 

 University Budget Officer 

 Associate Controller 

 Finance Systems Manager 

 Vice President  for Research (for all Grants) 
 

 

http://www.odu.edu/facultystaff/university-business/budget/development/forms
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Budget Unit Director Responsibilities 
 
University Policy #3001, Responsibility of Budget Unit Directors on Use of Funds 
(Expenditures), applies to all individuals designated as Budget Unit Directors having 
fiscal responsibility for University budgets.  Budget Unit directors are responsible and 
accountable for all budgetary and fiscal matters pertaining to their respective 
department/college or unit.  In instances where a fiscal transaction directly benefits the 
Budget Unit Director (e.g. travel expenses), the Budget Unit Director’s immediate 
supervisor must approve such transactions. 
 
Budget Unit Directors (BUDs) are charged with being stewards of funds provided by the 
Commonwealth and the University, and ensuring they are expended to best serve the 
University and its mission.  These responsibilities include: 
 

 Adequate planning for use of funds and determining the availability of funds prior 
to initiating any expenditure action (no matter the funding source); 

 

 Reviewing and ensuring all funds are expended in compliance with 
Commonwealth and/or University policies and that they are properly 
documented; 

 

 Ensuring the funds are expended for the intended purpose and relate to the 
mission of the University; and 

 

 Monitoring expenditures to ensure they do not exceed budget authority. 
 

Budget Unit Directors may delegate signature authority.  The delegation of signature 
authority does not relieve the BUD’s responsibility to ensure the appropriateness of the 
expenditure and compliance with Commonwealth and/or University Policies. 
 
Failure of BUDs to abide by these policies and procedures may result in revocation of 
fiscal authority, personal liability, and/or disciplinary action.  Please refer to the full 
policy for expenditure guidelines and allowable and disallowed expenditures. 
 
 http://www.odu.edu/content/dam/odu/policies/university/3000/univ-3001.pdf  
 
 

http://www.odu.edu/content/dam/odu/policies/university/3000/univ-3001.pdf
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Requesting Banner Finance Access 
 
If you currently have a Banner account and need to add finance access (or to obtain 
Banner access for additional/new budgets), the budget unit director (or someone higher 
in the organizational structure than the individual requesting access if that person is the 
BUD) can send an e-mail to Linda Meyers (lmeyers@odu.edu), Finance Systems 
Manager in the Office of Finance. 
 
If you do not currently have a Banner account, complete the Universal Account Request 
Form (available on the ITS web site).   
 
 http://www.odu.edu/content/dam/odu/offices/occs/docs/Universal%20Account%20Request%20Form.pdf  

 
Fill out the first page – Be sure to indicate the type of user.  Under “Accounts 
Needed,” check Banner.  After completing the form, print the form, sign and 
date.  Also at the bottom of the page, the Budget Unit Director (or someone 
higher in the organizational structure authorized to approve computer accounts) 
will need to complete the information in the authorization box and sign the form.   
 
On the second page:   
 

In Section C, include justification for obtaining the access (i.e., to be able 
to monitor budgets/research invoices). 
 
 In Section D, under Banner Classification Accesses Needed, request 
FIN_EVERYONE and list all budgets, including any ledger 6 budgets, to 
which you will need access. 

 
 

mailto:lmeyers@odu.edu
http://www.odu.edu/content/dam/odu/offices/occs/docs/Universal%20Account%20Request%20Form.pdf
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Master Signature List (Authorized Signature List)  

Individuals must be on the Master Signature List in order to sign against their budget 
codes for any purpose.  A list of some areas that use the Master Signature List is shown 
below. 

The Finance Systems Manager in Data Control is responsible for maintaining the 
Master Signature List for Old Dominion University.  To be added to the Master 
Signature List, please complete the Request to be Added to the Master Signature List 
form.  This fillable form is located on the Office of Finance website.  The budget unit 
director for the budget should approve the request.  Please note that continuation 
sheets must be submitted with the signed approval page.   

If the person to be added to the Master Signature List is the budget unit director, 
someone higher in the organizational structure must approve the request.   

NOTE:  Signature authority will only be granted to Old Dominion University employees. 

Current users of the Master Signature List include most service units that serve the Old 
Dominion University community: 

 Bookstore 
 Budget Office 
 Procurement Services   
 Technology Store  
 Telecommunications  
 Work Management (Facilities Management)  
 Payroll  
 Quick Copy  
 Accounts Payable  
 Mailroom 

Designating a Budget Unit Director 

Please note that adding an individual to the Master Signature List does not officially 
designate an individual as a Budget Unit Director (BUD).  To officially designate an 
individual as a Budget Unit Director, the main BUD or BUD’s supervisor should send 
notification to the Finance Systems Manager, Data Control, Office of Finance.  In 
Banner, the system shows the main BUD of record.   

BUD Delegates - Budget Unit Directors may assign responsibility to Budget 
Delegates.  These delegates will be able to approve all transactions/changes in 
the place of the main BUD, or responsibilities can be restricted to certain areas 
(i.e., Computer Account Requests).  These delegates are maintained in MIDAS 
and are maintained by the Finance Systems Manager.  Ultimate responsibility for 
departmental budgets rests with the main BUD. 

http://www.odu.edu/content/dam/odu/offices/finance-office/data/master-signature-list.pdf
http://www.odu.edu/content/dam/odu/offices/finance-office/data/master-signature-list.pdf
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PROCEDURES AND GUIDELINES FOR BUDGET MANAGEMENT 

Procedures and guidelines are necessary for managing budgets to ensure that Federal, 
State, and University policies are followed.  In addition, the guidelines provide 
assurance that the appropriate levels of management stay abreast of material changes 
to the budget.  The following information is updated annually near the beginning of the 
fiscal year and can be located on the Budget Office website. The actual web page 
containing the procedures and guidelines for budget management requires use of a 
Midas password to access this page. The contents from this web page are discussed in 
class. 
 
Budget Adjustments / Increases 
 
Budget re-allocations, both permanent and current, must be reviewed and 
recommended by the appropriate dean/director and approved by the appropriate senior 
executive officers. The University Budget Office approves and posts all budget 
adjustments.  The table below represents minimum requirements for approval of budget 
adjustments.   



 BUDGET MANAGEMENT AND FINANCIAL REPORTING  
 

  
 
Part of the Certificate in University Financial Management, revised February 16, 2017  Page 18 

 

Each Vice President has the ability to require additional levels of approval within 
their organizational structure.  The following chart shows University 
requirements. 

 

 
Type of Transaction 

 

 
Dollar Threshold 

 

 
Approval 

 

Within a Single Org Unit Up to $50,000 Dean or Director 

Within a Single Org Unit $50,000 to $1,000,000 All above PLUS the respective Vice 
President/Executive Officer 

Within a Single Org Unit $1,000,000 and up All above plus the Vice President for 
Finance & Administration or Chief 
Operating Officer 

Cross Org Units Up to $1,000,000 Respective Deans or Directors and Vice 
Presidents/ Executive Officers 

Cross Org Units $1,000,000 and Up All above plus the Vice President for 
Finance & Administration or Chief 
Operating Officer 

Exceptions: 

 Academic Affairs:  

o All budget adjustments and re-allocations must be routed through and approved 

by the Associate Vice President for Academic Affairs. 

o The Provost may centrally manage and / or allocate funding within Academic 

Affairs.  These transactions are approved and posted by the University Budget 

Office and require approval of the Vice President for Finance & Administration or  

Chief Operating Officer should they exceed $1,000,000. 

 The Budget Office retains delegated authority to record transactions related to Grants, 

Foundation Transfers, Revenues, Equipment Trust Fund, Fund Transfers, Financial Aid, 

Full-Time Salaries, Benefits, Capital Projects, Maintenance Reserves and other 

technical adjustments required by the Department of Planning and Budget.   

Additional Restrictions: 

 Departments may not move full-time salaries and fringes to NPS or any other areas 

without the Budget Office approval. 

 Federal work study funds (Managed by Career Development Services) may not be 

moved to any other account codes.  

 Only Budget Unit Directors of Auxiliary Services, CEPS, Grants, Agency Funds, and Gift 

Org Units may submit Revenue and Expenditure Increases/Decreases.  These 

transactions must be approved by the respective Vice President / Executive Officer. 
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Revenues 

Revenues are funds paid to the University for services provided to students, faculty, 
other agencies or the general public.  They may also be received in the form of 
donations via any of the University Foundations.  Revenues are recorded in the period 
in which they are earned, regardless of when the payment is actually received. 
 
The majority of University revenues are monitored and managed centrally, with the 
exception of Auxiliary Services, CEPS, Gifts/Grants, and Agency Funds.  Budget Unit 
Directors of these operating units are responsible for ensuring revenue budgets are 
developed and adhered to and must ensure the financial solvency of each respective 
operating unit. 
 
Personal Services Increases/Decreases   

 

The movement of funds among personal services and other expense categories of the 
budget must include a clear and concise reason for the change.  Approval is in the 
hands of the Dean or Director and Vice President.  If there is a pattern that materially 
changes the resource allocation, the Vice President for Administration and Finance or 
delegate will inform the President before acting on the request.  The resource 
allocations for personal services must be monitored to ensure payroll costs are covered 
for University employees. 
 
Overtime Pay 
 
It is necessary to justify and budget pay for overtime work in the budget process.  Send 
requirements after the budget process to the Budget Office for review.  If the request 
relates to a classified employee exempt from the Fair Labor Standards Act, have 
Human Resources review the request first.  Overtime increases are monitored and, 
where it appears there may be excessive use, the President's approval may be 
required.  (Overtime is calculated automatically by Banner based on web time entry 
submissions.  Not all employees are eligible for overtime.  Overtime is discussed in the 
Payroll training class.) 
 
Equipment 
 

 

 The State established the Equipment Trust Fund (ETF) Authority to meet special 
equipment needs.  
 

 The ETF program includes specific guidelines regarding the type of educational 
and research equipment that may be procured with ETF resources.  
 

 In addition to maintaining compliance with these guidelines, the University must 
also maintain a minimum level of equipment purchases from the operating 
budget.  
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 ETF funding can be reduced or completely taken away if the University does not 
meet the minimum requirements or follow the ETF guidelines (distributed to 
departments).   
 

 The transfer of equipment funding in the operating budget to other categories of 
expense is monitored closely to ensure compliance and may require approval at 
the Vice Presidential level. 

 
 

Central Services 
 

Services such as telephones, mail charges, and photocopy charges are provided 
through central operations.  As such, the costs are not invoiced, and the expense may 
appear in the budget sometime after the services are received.  This kind of activity 
needs to be monitored on a monthly basis to avoid expenses in excess of the approved 
budget authority.  Forecasting is very important to ensure accurate budget 
management.  Telephone charges and mail charges generally have 12 months of 
charges. 
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Fund Transfers  
 

Fund transfers are accounting transactions that move cash from one fund to another 
and are classified as mandatory and nonmandatory transfers (like moving money 
from one checking account to another).   

 
Mandatory transfers are made on the basis of a legal obligation such as the 
repayment of principal and interest on construction bonds. 
 
Nonmandatory transfers are made on the basis of needs within the University, 
and are done at agency discretion such as transfers from Housing and 
Residence Life to Facilities Management for custodial services, utilities, etc. 
 

Fund transfers should be included in the budget process for approval.  Requests to 
transfer cash after the budget process should be submitted to the Budget Office.  If the 
transfer materially impacts the operating budget, the Vice President for Administration 
and Finance or designee will consult the President for a decision.  If approved, the 
Budget Office will process the adjustment and notify the Assistant Vice President for 
Finance/University Controller that the transfer is approved. 
 
When a fund transfer is posted in Banner, you will typically see two budget entries. 
 

1. Increase or decrease expenditure sub-accounts  
2. Increase or decrease sub-accounts within the 99XX group 
  
The two entries are necessary to balance the respective budgets involved and have 
a zero effect on the bottom line of each budget.  The department receiving the cash 
in the transfer will see an increase to one of their expenditure budget pools or line 
items to represent the increased expenditure authority and see a decrease in a 
transfer line item to represent the transfer of cash into their budget/fund. 
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Position Actions  
 

New positions and position actions - Requests for new positions and changes 
to an existing position should be proposed during the budget process.  Only 
those that are approved in the budget process are usually acted on during the 
fiscal year.  Thorough justification is required if you feel a position should be 
reviewed during the year.  The first step in the process is to contact Human 
Resources to obtain the appropriate documents to be submitted.  The cost of out-
of-cycle requests will be funded from existing resources available in the budget.  
The President will provide funds only under extraordinary circumstances. 
 
Position transfers - Positions may be transferred from one budget unit to 
another with approval of the vice president when it does not materially change 
the level of effort in the operating plan.  The Budget Office reviews the request 
and sends it to Human Resources. 
 
Position recruitment - Before recruiting for a vacant faculty, faculty 
administrator or faculty professional position outside of Academic Affairs, the 
request must be reviewed and approved by the Provost.  Use the "Non-Academic 
Faculty and Administrative Position Allocation" form for this purpose.  This form 
as well as others utilized in the recruitment process and associated guidelines 
are available at: 
 
http://www.odu.edu/facultystaff/employee-services/managers/recruiting/recruiting-administrative-professional/forms.  

 
The completed form is sent through the Dean or Director and Vice President to 
the Budget Office.  The Budget Office refers the request to the Provost. 
 
Attrition Funds - Attrition funds are the monies remaining from a vacant position 
after all payroll and termination costs have been satisfied (i.e., classified leave 
payout). The types of positions that generate attrition are E&G funded faculty 
professional, faculty administrator and classified positions. Some examples of 
how attrition funds are generated include: (1) savings from positions being vacant 
for long periods of time, (2) savings when a member of the faculty or staff goes 
on leave without pay status.  
 
Attrition funds are placed in the University’s E&G contingency fund on a monthly 
basis via budget adjustment. The funds are used primarily to support unforeseen 
circumstances as well as to provide funding for specific projects that require 
funds on a one-time basis. Attrition funds may also be used to support 
emergency workload replacement or training needs at the request of the Budget 
Unit Director. Emergency workload replacement is to be associated with a 
specific vacancy in the budget unit.  
 
Attrition requests should be sent to the Budget Office and must include 
justification for the use of attrition funds. The Budget Office will review the 
request and provide a recommendation based on an analysis of available attrition 

http://www.odu.edu/facultystaff/employee-services/managers/recruiting/recruiting-administrative-professional/forms
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funding. The Budget Office will then notify the department with the outcome of 
the analysis. 
 
Surplus Salary Holding Account (4012) – This University funding practice 
associated with Compensation Reform enables budget units to retain surplus 
salary funds accrued from hiring new classified staff at an annual salary that is 
lower than the current base funding for the given position. 
 

 The Budget Office automatically calculates and reallocates the associated 
salary and benefit savings to the 4012 holding sub-account. 
 

 Budget managers have the latitude to utilize these funds for compensation 
reform actions or to reallocate them for operating budget requirements. 
 

 These reallocation actions may be made on a one-time basis or made 
permanent (base budget adjustment). 

 
The 4012 surplus salary holding account will be considered part of departmental 
base budgets unless the Vice President and/or Dean prefers that these turnover 
surplus funds be held in a central reserve within your division. 
 

Federal Workstudy Student Funds (4028) 
 

The Federal government provides an annual grant that provides for hiring students at a 
subsidized rate.  The grant provides 75 cents for every dollar of wage for students with 
a workstudy award.  It is important that the University maximizes the use of these funds.  
Therefore, funds for workstudy student positions may not be transferred to any other 
expense category.  Departments must monitor earnings to assure that students do not 
go into an over-award status.  All workstudy funds are managed through Career 
Development Services. 
 
University Gift Management   
 

All gift funds are to be deposited to the Educational Foundation or Intercollegiate 
Foundation as appropriate.  The foundations use the income from the investment of the 
gifts to support the operations.  The transfers of gift funds to the University for 
expenditure (ledger 6) are planned as part of the budget process and include only those 
gift funds reported as being available to the University after July 1.  Vice Presidents 
make recommendations for the use of the gifts in their budget materials.  The approved 
funds are then transferred from the appropriate foundation account and entered into the 
departmental gift budgets shortly after the fiscal year begins.  Ledger 6 budget balances 
from the prior fiscal year are loaded in late July, and the final adjusting balances are 
generally loaded in October, if applicable.   
 

Departments should not automatically request transfer of all spendable funds 
from the Educational or Intercollegiate Foundations, but should only request 
those funds that will be needed to effectively conduct business. 
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The use of Foundation gifts by the University is a part of the budget process:   
 

 Spendable Income Letter distributed by the Foundations in February detailing funds 
available for transfer on July 1.  
 

 VPs make recommendations during the budget process and submit requests to the 
Budget Office in July. 
 

 Funds transferred to the University in late September 
 
Exceptions may be made to the above policy if required by the donor of the gift. 

 

 An example would be a gift that is designated by the donor to be spent 
immediately.   

 The exception request is to be approved by the Dean or Director and 
Vice President 

 After approvals, the request is forwarded to the Budget Office.   

 The Budget Office will act on the request after conferring with the 
executive directors of the Educational Foundation and the Intercollegiate 
Foundation.  

 All foundation transfer requests should be forwarded to the Budget 
Office for processing. 

 
Fringe Benefits (4999 pool) 
 
Fringe benefits for full-time employees in E&G budgets are managed centrally.  Budget 
Unit Directors of Non E&G budgets must ensure sufficient funds are in 4999 to cover 
expenditures or make the appropriate budget adjustments. 
 

 E&G – centrally managed – no action required to balance 

 CEPS – must ensure sufficient funds in 4999 to cover benefits 

 Auxiliaries, Gifts and Grants – must ensure sufficient funds in 4999 to cover 
benefits 

 All Budget Unit Directors are responsible for monitoring and managing the 
benefits for their part-time positions (4021, 4031, 4027, and 4025 when students 
drop below the required credit hours) 

 
Benefit rates are adjusted on an annual basis to reflect changes in premiums and 
contract costs.  The University Budget Office publishes the benefits rates on its website. 
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Forecasting and Trends Analysis 
 
It is important for all Budget Unit Directors to regularly monitor their respective budgets 
and periodically assess revenue and expenditure trends of their budgets.  
Understanding the typical spending patterns in conjunction with planned program 
activities will enable better budget planning for future budget cycles as well as 
forecasting of current year operations.  It is the Budget Unit Director’s responsibility to 
ensure their budgetary units stay within budget authority.  Numerous Insight and ePrint 
reports may be utilized to assist Budget Unit Directors with both monitoring current 
budgets and analyzing revenue and expenditure trends. 
 
Departments should establish a routine monthly process to monitor and evaluate 
outstanding purchase requests/orders, recurring charges (part-time employees, phone, 
copier, Small Purchasing Card), planned one-time expenditures, and overall current 
spending. 
 
Budget Office Variance Analysis 
 
Budget Unit Directors are responsible for ensuring that budgets are monitored and any 
deficits are corrected in a timely manner.   
 
Budget Unit Directors are encouraged to use Insight, ePrint, and other tools to manage 
their budgets and ensure there are no negative variances.  Departments will be 
contacted if large variances occur.  The auditors recommend a formal once-a-month 
reconciliation.  The BUD should sign off on the reconciliation. 
 

Academic Affairs Variances 
The Vice President/Provost distributes certain types of funding to deans, and the 
deans distribute funding to departments after the items are expensed (i.e., 
funding for graduate assistants and adjunct faculty), so there may be times when 
negative variances occur.   

 
At the end of each fiscal year, the Budget Office conducts a formal analysis (Year-End 
Variance Analysis and Issues report) for each vice presidential area.  The purpose of 
the analysis is to provide actual expenditures and trends for each budget unit manager, 
enhance the budget development for the next budget cycle, and allow for evaluation of 
the budget management for all areas.
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Using Banner to Manage Your Budget 
(Refer to the HOW DO I Do Banner Internal Financial Reporting revised July 2011) 
 
Hard copy budget reports are not distributed to departments on a monthly or semi-
monthly basis.  A number of forms in Banner provide the information necessary to 
monitor departmental budgets online.   You may also wish to use ePrint to print your 
month-end reports (discussed later – mandatory training must be attended). 
 
Some general information about monitoring budgets 
 
The Budget Availability Status Form (FGIBAVL) can be used to help you determine 
balances in the pool accounts.  Periodically, it does not function properly and can show 
large, and sometimes inaccurate, deficits.  The Budget Office is aware of the 
discrepancy and will not rely strictly on FGIBAVL to determine true budget deficits. In 
the past several years, this phenomenon has occurred only twice. 
 
During times when budgets were out of balance, we discovered that a number of things 
cause the out-of-balance problems we were experiencing.  Some of them are inherent 
in the system, since items that are in suspense or entered in error will display in 
FGIBAVL until posted or cleared.   
 
Although we have resolved past problems with FGIBAVL showing inaccurate 
information, it is still possible that FGIBAVL and FGIBDST will not show identical 
information.   REMEMBER, FGIBAVL is updated as data is entered and displays approved 
and unapproved, posted and unposted transactions.   Please refer to "HOW DO I Do 
Banner Internal Financial Reporting.” 
 
You should continue to check your expenditures in Banner through the Organization 
Budget Status Form (FGIBDST) by linking to the Detail Transaction Activity Form 
(FGITRND).  As long as your internal records match with the expenditures and 
encumbrances posted, your budget should be in good shape.   
 
Even when FGIBAVL information is in balance, budget units are encouraged to 
reconcile budget information posted in the FGIBDST form against internal records.  By 
performing regular reconciliation for each budget, departments can avoid end-of-year 
deficit problems. 
 
Discrepancies from the Detail Transaction Activity Form (FGITRND) that cannot be 
identified once your budget is reconciled should be addressed through the Accounting 
Services Request (ASR) process.  Do NOT contact an Accounts Payable processor 
with questions about postings to your budget. 
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Budget Availability Status Form (FGIBAVL) 
This is a stand-alone form used to determine the available balance of a specific budget 
and provides available budget balances by line item and pools.  From the Options pull-
down menu, you can access Pending Documents (FGITINP) which shows pending 
transactions – no other research can be done from this form. 
 

By line item for  

 Personal services (4000 series of sub-accounts) 

 Expense recoveries  

 Transfers (99XX) 
 
At the pool level for  

 Benefits pool (4999 – 49XX sub-accounts except 4948 and 4949),  

 Nonpersonal services pool (6999 - 5000-6000 series of sub-accounts),  

 Travel pool (7999 - 7000 series of sub-accounts),  

 Equipment pool (9899 - 9000 series of sub-accounts)  
 

FGIBAVL shows the current operating expenditure budget, less year-to-date activity and 
commitments to arrive at the balance.  Refer to HOW DO I Check My Available Balance 
revised July 2011, for more details on how to use this form. 
 
This form is updated as data is entered and displays both approved and unapproved 
transactions.   
 
Actual detailed expenditure data is obtained through the Organization Budget Status 
Form (FGIBDST).  
 
Organization Budget Status Form (FGIBDST) – where you find details 
This form shows budget, actual activity and encumbrances and shows available 
balances by line item only.  It does not provide a net budget balance.  It also allows 
you to drill down to detailed information on a specific transaction.  You can perform 
detailed research from this form. This form is updated after posting and approval 
processes are completed.   Detailed instructions on how to access this Banner form are 
available in How Do I Check My Budget discussed during Banner training. 
 
Researching from the Organization Budget Status Form (FGIBDST) 
The following forms can be accessed from the Organization Budget Status Form 
(FGIBDST) by selecting the appropriate option. 
 

Organizational Budget Summary Form (FGIBSUM) 
This form shows a summary of budget information by revenue, total personal and 
nonpersonal expenditures and transfers (if applicable) for a specific organization.  
This form can be accessed from the Organizational Budget Status Form 
(FGIBDST) by selecting Budget Summary Information from the Options pull-
down menu. 
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Detail Transaction Activity Form (FGITRND) 
This form provides a detailed transaction listing of the sub-account highlighted on 
the Organization Budget Status Form (FGIBDST) and can be accessed by 
selecting Transaction Detail Information from the Options pull-down menu. 
You can use the scroll bar beneath the details to move the window pane to the 
right to reveal additional information about entries.  When requesting corrections 
to your budget, you should print the screen of information related to the 
transaction.  This form shows the details of expenditures in the selected sub-
object code.  The date an invoice is posted to this form (INEI or INNI) is the date 
the payment process starts and is not necessarily the date that a check was 
mailed.  To see a payment due date, you must review details of the invoice 
payment (FAIINVE). 
 

Invoice/Credit Memo Query Form (FAIINVE) 
This form shows the date that an invoice is scheduled to be paid and to 
what address a check will be mailed.  Can be accessed from the Detail 
Transaction Activity Form (FGITRND) by selecting Query Document from 
the Options pull-down menu when looking up information on invoices 
(INEI, INNI) when you see YTD in the Field column. 
 
Detail Encumbrance Activity Form (FGIENCD) 
When ENC shows in the column labeled Field, you can view the 
encumbrance activity.  (Once an encumbrance is liquidated, you can no 
longer view it from the Organization Encumbrance List Form, FGIOENC).  
This form shows detailed information about a specific encumbrance.  This 
form can be accessed by selecting Detail Encumbrance Information 
from the Options pull-down menu from FGITRND. 

 
Document Retrieval Inquiry Form (FGIDOCR) 
This form provides detailed information about all transaction types.  Can 
be accessed from the Detail Transaction Activity Form (FGITRND) by 
selecting  Query Document from the Options pull-down menu when 
looking up information on budget adjustments (BD02) and journal entries 
(JE35, etc.) when you see OBD, ABD, or YTD in the Field column. 

 
Document Postings Form (FGQDOCP) 
Shows how transactions post into each ledger.  This form can be 
accessed only from the Document Retrieval Inquiry Form 
(FGIDOCR) by selecting Access Document Postings from the 
Options pull-down menu. 

 
General Text Entry Form (FOATEXT) 
Shows text descriptions for journal entry type transactions, if 
entered.  This form can be accessed from the Document Postings 
Form (FGQDOCP) by selecting Document Text from the Options 
pull-down menu. 
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Organization Encumbrance List Form (FGIOENC) 
Shows detailed information about open encumbrances.  Can be accessed from 
the Organization Budget Status Form (FGIBDST) by selecting Organization 
Encumbrances from the Options pull-down menu. 
 

Detail Encumbrance Activity Form (FGIENCD) 
Shows detailed information about a specific encumbrance.  Accessed 
from the Organization Encumbrance List form (FGIOENC) by selecting 
Query Detail Encumbrance Info from the Options pull-down menu. 

 
 
Document History Form (FOIDOCH) 
This form shows the life of a document – purchase order, invoice, check, and receiving.  
(Refer to How to Research an Invoice Using the Banner Invoice Number). 
 
Vendor Detail History Form (FAIVNDH) 
You can see payment history for a specific vendor. 
 
Entity Name/ID Search (FTIIDEN) 
This form allows you to see if a vendor is in the University’s vendor table.  A vendor can 
be an eVA vendor but not be in the University’s vendor table.  If a vendor is not in 
ODU’s vendor table, the ordering department is responsible for obtaining a W-9 or 
W8BEN (international vendors).  Remember to use ALL CAPS. 
 
Budget Query Form (FBIBUDG)  
There are times when departments need to review the base budget versus the current 
operating budget.  FBIBUDG is query-only and enables departments to review 
continuation costs for a full fiscal year.  Only the University Budget Office has 
authorization to modify base budgets in accordance with the annual University budget 
approval process and as operating year adjustments impact the base.  Remember, 
base budgets do not reflect one-time funds.   
 
Perhaps the easiest way to illustrate the difference between a base and an operating 
budget is when a position is vacant for a period of time during the fiscal year.  Refilling a 
vacant position requires that funds be available to cover only those costs to be 
expended in the current operating year whereas the base budget must factor in the 
ensuing full fiscal year’s continuation costs.   
 
Departments who have access to FBIBUDG can review information on only those 
budgets requested on the Computer Account Request Form.  Questions about base 
budget information can be directed to the Budget Office at 683-3127. 
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Transaction Types 
 
Reviewing budget information is important.  To aid departments in understanding 
Banner Finance, the following transaction codes are provided. 
 
 
 
 Banner Code 

 
 Action 

 
Sign (debit or credit) 

 
Accounts Payable Entries 
 
ACCI 

 
Cancel Addl Chrgs on Inv w/G/L Acct 

 
 

 
ACDC 

 
Cancel Addl Charges on Credit Memo 

 
 

 
ACDI 

 
Cancel Addl Charges on Invoice 

 
 

 
ACEC 

 
Cancel Addl Chrg on C/M w/Encumb 

 
 

 
ACEI 

 
Cancel Addl Chrg on Inv w/Encumb 

 
 

 
ADDC 

 
Additional Charges on Credit Memo 

 
 

 
ADDI 

 
Additional Charges on an Invoice 

 
 

 
ADEC 

 
Addl Chrg on Credit Memo w/ Encumb 

 
 

 
ADEI 

 
Addl Charges on Invoice w/Encumb 

 
 

 
ADII 

 
Addl Charges on Invoice w/G/L Acct 

 
 

 
CNEI 

 
Cancel check - Invoice w/Encumbrance 

 
 

 
CNNC 

 
Cancel Check - C/M w/o Encumbrance 

 
 

 
DNEC 

 
Check - Invoice w/Encumbrance 

 
 

 
DNII 

 
Check - Inventory Invoice 

 
 

 
DNNC 

 
Check - C/M w/o Encumbrance 

 
 

 
DNNI 

 
Check - Invoice w/o Encumbrance 

 
 

 
CNNI 

 
Cancel Check Inventory Invoice 
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 Banner Code 

 
 Action 

 
Sign (debit or credit) 

 
ICEC 

 
Cancel Credit Memo w/Encumbrance 

 
 

 
ICEI 

 
Cancel Invoice with Encumbrance 

 
 

 
ICNI 

 
Cancel Invoice without Encumbrance 

 
 

 
INEC 

 
Credit Memo with Encumbrance 

 
 

 
INEI 

 
Invoice with Encumbrance 

 
 

 
INEP 

 
Invoice with Encumbrance Charged PY 

 
 

 
INER 

 
Credit Memo with Encumbrance PY 

 
 

 
INNC 

 
Credit Memo without Encumbrance 

 
 

 
INNI 

 
Invoice Without Encumbrance 

 
 

 
Encumbrance Entries 
 
COAD 

 
Additional Charge on Change Order 

 
 

 
CORD 

 
Establish Change Order 

 
 

 
E010 

 
Post Original Encumbrance (LPOs) 

 
 

 
E020 

 
Encumbrance Adjustment 

 
 

 
E032 

 
Encumbrance Liquidation 

 
+ or - 

 
E037 

 
Encumbrance Liq. allow changes 

 
 

 
E090 

 
Encumbrance Year End Roll 

 
 

 
E100 

 
Original Encumbrance 

 
 

 
PCAD 

 
Cancel Add=l Chrg on Purchase Order 

 
 

 
PCAP 

 
Canc Addl Chg on Purchase Order PY 

 
 

 
PCDP 

 
Canc Disc on Purchase Order Prior Y 

 
 

 
PCDS 

 
Cancel Discount on Purchase Order 

 
 

 
PCLQ 

 
Cancel PO - Reinstate Request 

 
 

 
PCRD 

 
Cancel Purchase Order 

 
 

 
PCRP 

 
Cancel Purchase Order in Prior Year 
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 Banner Code 

 
 Action 

 
Sign (debit or credit) 

 
POAD 

 
Additional Charge on Purchase Order 

 
 

 
POAP 

 
Additional Chg on PO Prior YR 

 
 

POCL Purchase Order Close  
 
PODP 

 
Disc on Purchase Order Prior Year 

 
 

 
PODS 

 
Discount on Purchase Order 

 
 

 
POLQ 

 
Purchase Order - Request Liquidation 

 
 

 
PORD 

 
Establish Purchase Order 

 
 

 
RCQP 

 
Cancel Requisition 

 
 

 
REQP 

 
Requisition - Reservation 

 
 

 
Accounts Receivable Entries  
 
IS01 

 
ISIS AR Legacy Interface * 

 
 

 
IS02 

 
ISIS AR Legacy Interface * 

 
 

 
CHS1 

 
Banner Student Charges/Non-Cash Pay 

 
 

 
CSS1 

 
Banner Student B Cash Payments 

 
 

 
 Budget Entries 
 
BD01 

 
Original Budget Entries 

 
+ or - 

 
BD02 

 
Permanent Budget Adjustments 

 
+ or - 

 
General Accounting Entries 
 
DCSR 

 
Direct Cash Receipts 

 
+ or - 

 
J001 

 
Year End Closing Journal 

 
D or C 

 
J020 

 
Budget Carry Forward Journal 

 
D or C 

 
JE05 

 
Beginning balances 

 
D or C 

 
JE35 

 
Transfer within funds 

 
D or C 

 
JE36 

 
Transfer within funds B Banner only 

 
D or C 

 
JE60 

 
Transfer between funds 

 
D or C 

 
JE61 

 
Transfer between funds B Banner only 

 
D or C 
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 Banner Code 

 
 Action 

 
Sign (debit or credit) 

 
 Payroll Entries 
 
HR01 

 
HRIS PR Legacy Interface * 

 
 

 
HEEL 

 
Payroll - Employee Liability 

 
 

 
HENA 

 
Payroll B Encumbrance Adjustment 

 
 

 
HENC 

 
Payroll B Salary Encumbrance 

 
 

 
HERL 

 
Payroll - Employer Liability 

 
 

 
HGNL 

 
Payroll B Gross Expenditure 

 
 

 
HGRB 

 
Payroll B Gross Benefit Expense 
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MANAGING/MONITORING BUDGETS 
 
Departments are responsible for monitoring budget activity and resolving any budget 
variances timely (recommended monthly).  Banner is the University’s official financial 
record and any discrepancies or errors must be reported and corrected via the 
appropriate process.  Please refer to the Error Correction Process section.  
 
Researching Invoices 
 
If you need to see if an invoice has been paid, you should research the invoice before 
calling the Accounts Payable processors.  Please keep in mind that the date an invoice 
is posted in Banner is the date that the payment process begins and is not always the 
date the payment was sent to the vendor.  If you have not completed the e-receiver 
in Banner - the payment process cannot begin.  The completed e-receiver serves 
as payment authorization.  (Refer to Procurement and Payment for Goods and 
Services for more information.)   
 
If you cannot find the information you need, please contact the appropriate 
processor.  You will need to provide: 
 

1. The purchase order number (or UIN if payment was made to an individual) 
2. The vendor name 
3. The invoice number 
4. And the date the e-receiver was completed in Banner.   

 
You can check FOIDOCH to see if the invoice has been received and/or the e-
receiver has been completed. 

 
The information on the following pages is available to all Banner Finance account 
holders and is available on the Office of Finance web site at the following address: 
 
 http://www.odu.edu/facultystaff/training-development/banner-training/finance-budget  

 
 

http://www.odu.edu/facultystaff/training-development/banner-training/finance-budget
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 How to Research an Invoice Using the Banner Invoice Number 
 
 ACTIONS/STEPS 

 
 NOTES/HINTS 

 
 Access the Document History Form 

 
Type FOIDOCH in the  “Go to” box 
and press <ENTER>.   

 
 The Document History Form (FOIDOCH) contains two (2) blocks 

which must be completed:  
 

 Doc Type. Type INV (for invoice) or PO (for purchase order) 
 Doc Code: Type the invoice number or PO number 

 
The invoice number used in this 
form is the system-generated 
document number which begins 

with AI@ that can be found in 

FGITRND. 
 
 Perform the Next Block function to load all the information about 

the invoice. 

 
Ctrl + Page Down 

 
 A number of different windows of information will be displayed.  In 

the Invoice window, the invoice number will be displayed.  In the 
Check window, the check number will be displayed if a check has 
been issued.  A one-character Status Indicator displays the 
status. 

 
Under “Invoice,” if you see an R displayed, you need to complete an 
e-receiver in Banner.  If no invoice information displays, invoice has 
not been received and/or scanned/indexed. 
 
Under “Receiver,” you can see the receiving documents associated with 
the invoice.  Must display a “C” for completed. 
 
Under “Check,” you can see the check number. 

 
Status Indicators (legend) 
(A) Approved 
(C) Completed 
(F) Final Reconciliation 
(P) Paid 
(R) Receipt Required (needs e-
receiver) 
(S) Suspended 
(O) Open 
(X) Cancelled 
(V) Void 
(H) Hold 
(T) Tagged Permanently 

 
 To find the check date, make sure the Check window is 

highlighted. 

 
Use your mouse pointer to click 
into the Check window.  On most 
screens it will be highlighted in 
blue. 

 
 Select Check Information from the Options pull-down menu. 

 
 

 
 This will take you to a blank Check Payment History Form 

(FAICHKH) with the Check Number filled in.  Fill in the Bank # 
(50 or 01).  Use the Next Block function to display all the 
information about the check. 

 
 
 
 
Ctrl + Page Down 

 
 The top portion of this window of the form displays the Check 

Number, Vendor, Check Date, and Cancel Date (if applicable).  
Checks are scheduled to be mailed within seven (7) work days of 
the check date.  If a check was cancelled for some reason, the 
date of cancellation will be displayed. 

 
Since all checks are done as a 
“batch.” It is possible that the check 
will include payments for multiple 
invoices. 

 
 Once you find all the information you need on a specific invoice, 

click on the Exit icon in the toolbar and you will be returned to the 
Document History Form (FOIDOCH) displaying the various 
windows of information about the invoice (Invoice, Check, etc.). 

 
  

 
 If you wish to perform research on another invoice, click on the 

Rollback icon in the toolbar.  This will take you back to the 
FOIDOCH form key information area.  

 
The Rollback icon is the second 
from the left on the toolbar. 
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 How to Research an Invoice Using Vendor History 
 
 ACTIONS/STEPS 

 
 NOTES/HINTS 

 
 Access the Vendor Detail History Form 

 
Type FAIVNDH  in the “Go to” field 
and press <ENTER>.   

 
 The key information area of the Detail History Form (FAIVNDH) 

contains three (3) fields which must be completed:  
 

 Vendor:  Enter the Vendor Number  
 Selection: Defaults to All 

 Fiscal Year:  Defaults to current fiscal year 

 
Other selections are 
 

Credit Memo 
Open 
Paid 

 
 Perform the Next Block function to load all the information about 

the vendor=s payment history.  The following information is 

displayed: 
 

 Vendor Invoice is a listing of all invoices for this vendor 

 Invoice refers to the system-generated reference number 

 Approval  shows if an item was approved (Y or N) 

 VIC Ind (not used at this time) 

 Credit Memo shows if an item is a credit memo (Y or N) 

 Open/Paid indicates O(pen) or P(aid) 

 Cancel shows if an item has been cancelled (Y or N) 

 Vendor Invoice Amt is the amount of that specific 
transaction 

 Due Date displays the date an invoice is expected to be 
paid 

 Check Date when the check is cut, displays the check 
date 

 Check Number (click on the Details icon  to see check 
details) 

 
Ctrl + Page Down 
 
 
 
When you view a listing of vendor 
invoices, keep in mind that all 
invoices processed by the 
University for this vendor are 
shown here. 

 

You can also view the invoice info 
by selecting View Invoice 
Information from the Options  
pull-down menu. 

 

The check date is generally about a 
week before mailing – allows for 
auditing. 

 
 Click on Rollback to return to the key information area of the form 

to review the payment history for another vendor. 

 
 

 
 Remember to log out of Banner to assure the security of 

information. 

 
Click on the Exit icon in the toolbar. 
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Downloading Budget Information from Banner (into Excel) 
 
Departments can download select budget data into Excel spreadsheets.  This provides 
departments with another tool to more effectively manage budgets.  This download 
process should not be confused with the Insight budget reports available via Insight 
(see next section).  You can only download data for budgets to which you have Banner 
access.  You may not have access to all forms if they are not included in your current 
Banner access.  Once you have set up your output options that determine where you 
want your Excel files stored, you can download information. 
 
The Banner forms in the chart below contain select information that can be downloaded 
into a basic Excel spreadsheet.  Once you download the information, you can modify 
the spreadsheet formatting to suit your needs. 
 
The full documentation about downloading to Excel can be found on the Office of 
Finance web site (part of the Banner Finance training) and in the appendix of this 
document: 
 
For the following forms, from the Help pull-down menu – select ”Extract Data with Key.” 
 

Form Name Descriptive Name Info Contained Notes 

FGIBAVL Budget Availability Status Summary data at org level  Shows line-item sub-accounts 
and pool accounts 

FGIBDSR Executive Summary Summary budget data at any org 
level, including fund 

 

FGIBDST Organization Budget Status Summary budget data at org level Shows all sub-accounts 

FGIBSUM Organization Budget Summary Summary by account type  

FGIDOCR Document Retrieval Inquiry Transaction detail for any completed 
document 

 

FGIENCD Detail Encumbrance Activity Contains encumbrance detail – 
shows payee, vendor number, 
coding and amounts – downloads 
header, encumbrance number and 
accounting distribution only 

Vendor number DOES NOT 
download to Excel. 
 
Individual transactions do not 
download. 

FGIJSUM Journal Voucher Summary Shows incomplete journal entries For use with incomplete 
journal vouchers only. 

FGIOENC Organizational Encumbrance List Shows open encumbrances by 
number, payee and amount – no 
vendor numbers 

 

For the following forms, from the Help pull-down menu - select “Extract Data No Key.” 
 

Form Name Descriptive Name Info Contained Notes 

FGIENCB Encumbrance List Shows encumbrance list by number, 
amount and date – no vendor 
numbers 

WARNING – do not try to 
download the entire list – it is 
too large.   
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Insight Budget Reporting 
 
Insight Budget Reporting is another tool that may be leveraged to monitor and manage 
budgets.  The data used for these reports is read from the Operational Data Store 
(ODS), which is created from the Banner database and is currently refreshed daily 
between Midnight and 6AM every day.  The refresh picks up all changes in Banner 
since the last refresh and performs an ETL (Extract, Transform, and Load) process on 
the data to make it more useful and user-friendly for reporting purposes.  The reports 
are not updated as activity is posted during the day.  
 
Please feel free to contact Bruce Aird, Associate Budget Officer with any questions 
about utilizing the Insight Budget Reports and/or the data contained in the Budget 
Reports. (683-3127 or baird@odu.edu). 
 

 Insight is currently being updated. 

 You no longer need to activate Insight via MIDAS. 

 You must have the appropriate Banner access to all the budgets you wish 
to view. 

 If you have access to a specific budget, you will have access to Insight reports 
for that budget. 

 Insight reports can be easily saved as a PDF or Excel document or e-mailed 
directly from Insight for easy distribution and use. 

 Reports may be scheduled to run on specific dates/times. 

 Detailed training on Insight Reporting is provided periodically by the Budget 
Office. 

 Please refer to the Appendix in this handout for the most recent full 
documentation for Insight Budget Reporting. 

 
http://insight.odu.edu/ 

 
There are multiple reports and report options available via Insight: 
 

 Base Budget 

 Budget Trend 

 Current Operating Budget (OPAL) 

 Fund/Auxiliary Budgets 

 Transaction/Sub-account Detail 
 
Here are just a few of the reports available: 
 

 COB by Budget by Revenue/Expense/Transfers (FGIBDST) 

 COB by Budget by Revenue/Expense/Transfers by Subaccount (FGIBDST) 

 Current Operating Budget Revenue Report (FGIBDST) 

 Auxiliary Fund Rollup Report 

 Negative Budget Balances Report (FGIBAVL) – by Budget Code/Hierarchy 

 Budget Transactions Matrix Report (FGITRND) – total reconciliation trail 

mailto:baird@odu.edu
http://insight.odu.edu/
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Budget Report Menu 
 

 
  
 

Budget Transaction Matrix Report 
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Printing Month-End Financial Reports via ePrint 
 

What is Banner ePrint? 

The Office of Finance does not provide monthly budget reports to departments.   Banner ePrint 
allows users to print monthly financial reports as soon as they are available – usually the first 
business day of the month.  Please ensure that you see the message indicating that financial 
reports have been validated before using any budget reports via ePrint.   

Employees who monitor and report on budget and payroll activity can obtain access to 
ePrint. 

Access to departmental Payroll reports must be requested separately.  To request 
access to Payroll reports in ePrint, complete this form: 

http://www.odu.edu/content/dam/odu/offices/finance-office/data/payroll-eprint-request.pdf  

Before the access is granted, all users must attend Office of Finance ePrint training. 

ePrint allows a user to view reports as a PDF (Adobe Portable Document Format) file which can 
be viewed via Adobe Reader or to download a CSV file into Excel.  Keep in mind that when you 
download a CSV file, you must format the size of the columns to display all information.   

You must have a Banner account with the appropriate access in order to use ePrint.  When you 
log into ePrint, you will use your current Banner User ID and your Banner password.   

  
 https://gutenberg.imgr.odu.edu/cgi-bin/eprint.cgi 

 

Here is a screenshot of a sample budget report from ePrint. 

 

 

 

See the appendix for the full documentation on ePrint.  Documentation is provided to individuals 
who attend ePrint training. 

http://www.odu.edu/content/dam/odu/offices/finance-office/data/payroll-eprint-request.pdf
https://gutenberg.imgr.odu.edu/cgi-bin/eprint.cgi
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Payroll Reports 
 
 
The payroll reports contain information by budget unit, employee, and payroll number 

and are useful in determining each employee=s charge for a specific payroll and check 

date. The top of the form shows the reporting period covered (i.e., 01-JUL-2011 to 31-
JUL-2011). Refer to the Payroll schedule, published annually, to determine the specific 
payroll number. The Banner payroll reports are available via ePrint each month.   
Contact Data Control at 683-3257 if you have questions about your Payroll reports.   
 
Payroll reports are available via e-Print for those individuals who have the appropriate 
access (see previous page).  Be sure to DRILL DOWN to see details.     
 

 
 
PAYROLL REPORT MOCK-UP – Payroll reports are broken down by budget code, sub-object 

code, and employee. 

 

REPORT: NHRSDST   Old Dominion University     PAGE       1 

Empl Payroll Summary By Orgn 

Reporting Period:  01-JUL-2011  To: 31-JULY-2011 

 

COAS:  U Organization:  OFFICE NAME 

 

Fund Orgn Acct Prog Actv Locn 

011001 1XX00 4001 161 * * 
 

ID/Name EARNINGS 

Hours 

EARNINGS 

Amount 

BENEFITS 

Amount 

Total 

Hours 

Total 

Amount 
12345678  EMPLOYEE, SUZIE Q     

2006 FT  311  0 86.67 3,994.75 .00 86.67 3,944.75 

      
Empl Total 86.67 3,994.75 .00 86.67 3,994.75 

FYTD Total 86.67 3,944.75 .00 86.67 3,994.75 

 
      

Fund Orgn Acct Prog Actv Locn 

011001 1XX00 4002 161 * * 
 

  

ID/Name EARNINGS 

Hours 

EARNINGS 

Amount 

BENEFITS 

Amount 

Total 

Hours 

Total 

Amount 
23456789  WORKER, JAMES X     

2006 FT   311   0 86.67 1,729.88 .00 86.67 1,729.88 

      

Empl Total 86.67 1,729.88 .00 86.67 1,729.88 

FYTD Total 86.67 1,729.88 .00 86.67 1,729.88 
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Resolving Budget Discrepancies (IDTs and Accounting Service Request) 
 
The Office of Finance is responsible for researching and resolving errors when 
University departments discover inappropriate or unidentifiable expenditures against 
their budgets.  There are two mechanisms available to departments.    
 

 The IDT process should be used when you know specific correction information.  
 

 The Accounting Service Request (ASR) process must be used to initiate 
research when you cannot identify why the charge was made to your budget. 

 
http://www.odu.edu/facultystaff/university-business/information-management/data-control/accounting-service-request-process  

 
Interdepartmental Transfers (IDTs)  
 
IDT forms are prepared when financial accounting entries need to be recorded.  
Transactions for budget corrections, transferring charges (reimbursing) to other 
departments and recording expense charges are examples of why IDTs are processed. 
 
IDT forms are located on the Office of Finance web site under Faculty/Staff forms.  The 
forms are fillable PDF forms and can be saved to your computer.  Completed forms 
must be signed, scanned, and e-mailed to IDTs@odu.edu 
 
The form must be completed as follows: 
 

 All fields in both the charge and credit information areas must be completed 
 

o Charge information 
 Organization/account 
 Department name 
 Contact name 
 Contact phone 
 Authorized signature 

 
o Credit information 

 Organization/account 
 Department name 
 Contact name 
 Contact Phone 
 Authorized Signature 

 
o Accounting Distribution for Charge (Fund, Org, Sub-Account, Amount) 

 
o Accounting Distribution for Credit (Fund, Org, Sub-Account, Amount) 

 

 An explanation must be provided, including any applicable document reference 
numbers. 

http://www.odu.edu/facultystaff/university-business/information-management/data-control/accounting-service-request-process
mailto:IDTs@odu.edu
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 Supporting documentation must be included and must be clear and concise.  
Backup documentation can include: 
 

o Printed Banner reports 
o Screen prints from Banner 
o E-mail correspondence 
o Invoices 
o Notes or memos 
o Tear sheets, ad copies or publications 
o Transportation or event tickets 
o Receipts 
o Other materials relating to the entries 

 

 Debit amounts must match the credit amounts 
 

 If original charge noted, this indicates that the transaction is a charge from one 
department to another and the supporting documentation should show the goods 
and services that were provided. 

 

 If correction of charge is noted, this indicates that the transaction is for one 
department to reimburse another department, and the supporting documentation 
must show the original transaction in Banner where the department being 
reimbursed was originally charged. 

 

 The IDT continuation sheet should be used as needed. 
 
 
All transactions must be thoroughly supported by documentation explaining the need for 
the action, including attaching all applicable Banner screenshots.  Appropriate approval 
signatures are required for all budget units affected and the preparer’s contact 
information must be included in case there are questions about the requested 
transactions. 
 
IDT transactions show up in Banner as a JE35 (within the same fund) or JE60 (between 
funds) journal entry. 
 
Submitting the IDT: 
 
Completed forms must be signed, scanned, and e-mailed to IDTs@odu.edu 
Ensure that you have included supporting documentation in your e-mail.

mailto:IDTs@odu.edu
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Accounting Service Request (ASR)  
 
The ASR process is used to research charges.  Coding corrections must be submitted 
using an Interdepartmental Transfer (IDT) form.   
 

1. As you reconcile your budget, unidentifiable charges need to be 
researched and resolved.  Review your budget transactions through the 
Organization Budget Status Form (FGIBDST). 

 
2. If you find unidentifiable charges, complete an Accounting Service 

Request (ASR) form (available from the following web page) with the 
following information. 

 

a. Date 
b. Department Name 
c. Contact Name (Person preparing the form) 
d. Telephone number 
e. E-Mail address 
f. Details of research requested: 
  

 Fiscal year 

 Original Doc # in Banner 

 Dollar Amount 

 Notes to assist research  
 
 

3. Please keep a copy of this form and e-mail the completed PDF form to 
DataControlASR@odu.edu.  Be sure to include screenshots of all back-up 
documentation.   

 
4. When the ASR form and documentation are received, the Data Control 

Representative reviews the form and documentation.   
 

a. If any information or documentation is missing, to the department 
will be contacted outlining what additional information is required. 

 
5. If all information and documentation is complete, the form is processed. 

 
6. A reference number is assigned to the ASR, and that number is returned 

to the department via e-mail.  Please use the reference number when 
following up on the problem.  Data Control is responsible for monitoring 
and tracking problem resolution. 

 
7. The original ASR form and supporting documentation are forwarded via e-

mail to the appropriate area in the Office of Finance for research and 
resolution. 
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8. When the problem has been resolved or the charge identified, the 
department is notified of the action taken to resolve the issue. 
 
The correcting entry will be posted to your budget via a journal entry.  
On FGITRND, the description will contain the ASR number. 

 
9. Response times can vary, depending on the research required.  

Generally, most issues can be resolved within 14 work days. 
 

10. Questions about the status of specific Accounting Service Requests 
should be directed to DataControlASR@odu.edu.  Please reference the 
assigned number in any correspondence. 
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PART I:  MULTIPLE CHOICE.  DIRECTIONS:  Circle the correct response(s). 
 
1. Fund transfers move cash from one fund to another and are classified as 
 

a. Emergency and non-emergency 
b. Mandatory and nonmandatory 
c. Transferable and nontransferable 
d. All of the above 
e. None of the above 

 
2. A budget adjustment within a single org unit that requests an increase of $50,000 

must be approved by 
 

a. The President 
b. The Vice President for Administration and Finance 
c. The Budget Office 
d. The Dean or Director 

     
3. All gift funds should be initially be deposited where? 
 

a. The Cashier’s Office 
b. The regular E&G budget for your department 
c. The departmental discretionary budget 
d. The Educational or Intercollegiate Foundation, as appropriate 
e. None of the above 

 
4. A budget adjustment between org units that requests an increase of $20,000 

must be approved by 
 

a. The President 
b. The respective Deans/Directors and Vice Presidents/Executive Officers 
c. The Vice President for Administration and Finance 
d. The Provost 

 
5. What statements are true about Interdepartmental Transfers? 
 

a. All fields in both the charge and credit information areas must be 
completed. 

b. An explanation must be provided. 
c. Supporting documentation must be included and be clear and concise. 
d. Backup documentation can include Banner screen prints. 
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6. What Banner form is used to check the available balances at the pool account 
level for Benefits, Nonpersonal Services, Travel, and Equipment and at the 
detailed level for personal services for your departmental budget? 

 
a. Organization Budget Summary Form (FGIBSUM) 
b. Organization Budget Status Form (FGIBDST) 
c. Budget Availability Status Form (FGIBAVL) 
d. Detail Transaction Activity Form (FGITRND) 

 
7. What Banner form is used to view the budget and expenditure totals by line item? 
 

a. Organization Budget Summary Form (FGIBSUM) 
b. Organization Budget Status Form (FGIBDST) 
c. Budget Availability Status Form (FGIBAVL) 
d. Detail History Form (FAIVNDH) 
 

8. What Banner form is used to show a summary of budget information by revenue, 
total personal and nonpersonal services, and transfers for a specific budget? 

 
a. Organization Budget Summary Form (FGIBSUM) 
b. Organization Budget Status Form (FGIBDST) 
c. Budget Availability Status Form (FGIBAVL) 
d. Detail History Form (FAIVNDH) 

 
9. If you have insufficient funds available in your budget because an expenditure 

was posted to the incorrect sub-account, what action should you take? 
 

a. Process a budget adjustment to increase the budget in the sub-account 
affected. 

b. Request error correction from the Office of Finance by sending an IDT  
form and supporting documentation.  

c. Request that Accounts Payable override the insufficient funds message. 
d. Do nothing and hope the problem will resolve itself. 

 
10. If you wish to do business with a vendor and can’t locate a vendor number in 

Banner, which office do you contact for assistance? 
 

a. Procurement Services 
b. Budget Office 
c. Accounts Payable 
d. Accounts Receivable 
e. The vendor supplying merchandise 
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PART II:  TRUE OR FALSE 
DIRECTIONS:  Please answer TRUE (T) or FALSE (F) for each of the following 
responses: 
  
       1. If the Banner Organization Budget Status Form (FGIBDST) shows a 

negative balance available in office supplies (6002), your next attempt to 
order office supplies with a purchase order will reject. 

 
       2. Federal workstudy student funds can be transferred to cover other 

operating expenses. 
 
       3. The document number on the Detailed Transaction Activity Form 

(FGITRND) is assigned by the Budget Office. 
 
       4. There is no way for departments to research invoices without the 

assistance of Accounts Payable. 
 
       5. Budget adjustments should be used to correct expenditures charged to 

the wrong budget. 
 
        6. You can research detailed transactions through the Budget Availability 

Status Form (FGIBAVL). 
 
       7. Budget Unit Directors are required to monitor budgets to ensure there are 

no unexplained variances. 
 
       8. The budget adjustment form is used to request changes to the current 

operating budget, the base budget, or both, within existing policies and 
procedures. 

 
      9. Budget adjustments within a single org unit of $100,000 must be approved 

by the Dean/Director plus the respective Vice President/Executive Officer. 
 
      10. Use of the remarks section on the budget adjustment form is optional. 
 
       11. To review detailed information about a specific encumbrance, use the 

Detail Encumbrance Activity Form (FGIENCD). 
 
      12. There is no way to view encumbrance details once an invoice has been 

paid and the purchase order is liquidated. 
 
      13. A vendor cannot be paid if there are insufficient funds, even when the 

encumbrance has reserved the funds. 
 
       14. You can view the vendor payment history in Banner. 
 
       15. The accrual period is referred to as the 13th month. 
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      16. Old Dominion University is on the cash basis of accounting. 
 
       17. The budget transaction code in Banner that indicates original budget load 

is BD01. 
 
      18. The budget transaction code in Banner that indicates budget adjustment 

activity in Banner is BD02. 
 
       19. An interdepartmental transfer can be used to move expenditures from one 

budget to another. 
 
       20. Before recruiting for a vacant faculty, faculty administrator or faculty 

professional position outside of Academic Affairs, the request must be 
reviewed by Human Resources and approved by the President. 

 
 
 
 ANSWERS TO SAMPLE TEST 
 
PART I -- MULTIPLE CHOICE 
 
 1. b 
 2. d 
 3. d 
 4. b 
 5. a, b, c, d 
 6. c 
 7. b 
 8. a 
 9. b 
10. c 
 
 
 
PART II -- TRUE OR FALSE 
 
 1. False    11. True 
 2. False    12. False 
 3. False    13. False 
 4. False    14. True 
 5. False    15. True 
 6. False    16. False 
 7. True    17. True 
 8. True    18. True 
 9. True    19. True 
10. False    20.  False
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BUDGET OFFICE WEB PAGE PRINTOUT 
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OPERATING BUDGET INSTRUCTIONS  
 
http://www.odu.edu/facultystaff/university-business/budget/development/instructions  
 
 

 
 
 
 

http://www.odu.edu/facultystaff/university-business/budget/development/instructions
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DOWNLOADING BUDGET INFORMATION FROM BANNER 
 
Departments can now download select budget data into Excel spreadsheets.  This provides departments 
with another tool to more effectively manage budgets.  This download process should not be confused 
with the Cognos budget reports available via Insight.  You can only download data for budgets to which 
you have Banner access.  You may not have access to all forms listed in this handout if they are not 
included in your current Banner access.  Once you have set up your output options that determine 
where you want your Excel files stored, you can download information.   
 
Set up your output options 
 
Before you can download from Banner, you must first tell Banner where you would like your output 
(Excel file) stored.  You do that in the General User Preferences Maintenance form (GUAUPRF) which 
can be accessed from the File pull-down menu (click on Preferences from the file pull-down menu). 
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Determining where data will be stored 
 
Select the second tab entitled “Directory Options.” 
 
The top description is “Local directory for saving output.”  The default location, or value, where files are 
stored is c:\temp.  User Value can be changed to reflect where you want your Excel output to be stored, 
i.e., h:\backup.   That is the only thing you should change – leave everything else as it defaults, unless 
you have made changes to your settings (see next page). 
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Be sure that FILE displays as both the default value and user value for the data extract format.  If you 
have changed those settings, they must be set to FILE in order to download data.   Enter the User Value 
where you want your files stored (under Local directory for saving output).  Click Save.  You will see the 
message that the transaction is complete and you can exit from GUAUPRF (General User Preferences 
Maintenance form).   
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The following forms contain select information that can be downloaded from Banner into a basic Excel 
spreadsheet.  Once you have set up where you want your Excel files to be stored, you can download 
information into a generic Excel spreadsheet.  Remember, what you can download depends on your 
Banner access. 
 

For the following forms, from the Help pull-down menu – select ”Extract Data with Key.” 
 

Form Name Descriptive Name Info Contained Notes 

FGIBAVL Budget Availability Status Summary data at org level  Shows line-item sub-accounts 
and pool accounts 

FGIBDSR Executive Summary Summary budget data at any org 
level, including fund 

 

FGIBDST Organization Budget Status Summary budget data at org level Shows all sub-accounts 

FGIBSUM Organization Budget Summary Summary by account type  

FGIDOCR Document Retrieval Inquiry Transaction detail for any completed 
document 

 

FGIENCD Detail Encumbrance Activity Contains encumbrance detail – 
shows payee, vendor number, 
coding and amounts – downloads 
header, encumbrance number and 
accounting distribution only 

Vendor number DOES NOT 
download to Excel. 
 
Individual transactions do not 
download. 

FGIJSUM Journal Voucher Summary Shows incomplete journal entries For use with incomplete 
journal vouchers only. 

FGIOENC Organizational Encumbrance List Shows open encumbrances by 
number, payee and amount – no 
vendor numbers 

 

For the following forms, from the Help pull-down menu - select “Extract Data No Key.” 
 

Form Name Descriptive Name Info Contained Notes 

FGIENCB Encumbrance List Shows encumbrance list by number, 
amount and date – no vendor 
numbers 

WARNING – do not try to 
download the entire list – it is 
too large.   

 
DOWNLOADING TO EXCEL – access the Banner form you want to download, populate the form, and 
select the appropriate extract key from the Help pull-down menu. 
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You are now prompted to open or save the file.  Note the default file name.  You will want to 
change this when you save. 
 

 Open the file if you want to work with it immediately. 

 Save the file if you want to save it and work with it later. 

 Cancel to stop the download process. 
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When you wish to save the file, name your file and save it.  You may choose another location 
for your file to be stored. 

 
When you open the file, you will note that all columns are the same size – you can modify the 
spreadsheet formatting to suit your needs.  When retrieving the file in Excel, you may need to 
change the file type to “all files” to locate the new file in the file list. 
 

 

 

PROBLEMS 

Please send questions, concerns or problems to bannerhotline@odu.edu.   

mailto:bannerhotline@odu.edu
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APPENDIX – INSIGHT BUDGET REPORTING 
 
The most recent documentation is always contained on-line at insight.odu.edu. 
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Data Refresh/Update Times  

Finance data which is used for reporting using Cognos is read from ODS. ODS is Operational Data Store 

which is a Sungard product.  

ODS is created using data available in Banner database. After initial load of banner data in ODS, ODS is 

refreshed from Banner on regular frequency. Currently we refresh the data in ODS on daily basis. Data is 

refreshed between Midnight and 6 AM every day. Refresh picks up all the changes in banner since last 

refresh and performs an ETL(Extract, Transform and Load) process on the data and makes it more useful 

and user friendly for reporting purposes. Please contact BI team at insight@odu.edu if you would like to 

get more detailed understanding on the process and timings or if you have any questions about Cognos 

reporting. For data related issues please contact Budget Office. 

 

 

Security: “Fund Org” Security 

Banner security currently allows users access to only those budget codes and fund codes within their 

realm of responsibility. Insight functions the same way: you only have access to the budget and fund 

codes which you are authorized to query in Banner. 
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Data Definitions 

Account Description 1: A rollup category description of similar subaccounts ( 

Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, Revenues Categories) 

Adjustments: Changes made to the base/operating budget on a year-to-date basis. 

Balance: Computed total of Current Budget minus year-to-date activity and pending 

encumbrances. 

Base Budget: Annualized budget that can change during the course of an operating 

budget year, may be modified during the budget process, and then rolls into operating 

for the ensuing operating year. Sometimes referred to as the ‘Original Budget’ at the 

start of the operating budget year. 

Budget Code:  5 digit code that indicates a particular budget (1ED00 for Dean, College 

of Education) . 

College/Division: Lists the hierarchical grouping of colleges/divisions throughout the 

VP Areas (i.e., College of Business, College of Science, Recreational Sports, Facilities 

Management). 

Current Budget: The calculation of the original base budget plus year-to-date budget 

adjustments.  

Debt Service: Principle and interest payments tracked in subaccounts 9951 and 9952.  

Encumbrances: Budget obligations/commitments for goods/services which have been 

procured (i.e., pending equipment orders). When a purchase order is issued, the funds 

for the purchase must be reserved. The process of reserving the funds is referred to as 

encumbrance. Once funds are encumbered, they are removed from the balance 

available. This prevents over-expenditures from occurring. 

Equipment: Budget category rollup of equipment subaccounts between 9000 and 9899. 

Expenditures: Refers to the actual funds expended. When a vendor bill is paid, it 

becomes an expenditure. 

Expense: sum of categorical  account groups ( Personnel, Fringe Benefits, NPS, 

Travel, Equipment). 

Fiscal Year: Period of time for accounting that starts on July 1 of a calendar year and 

ends on June 30 of a calendar year.  

Fringe Benefits: Budget category rollup of fringe benefit line items such as Social 

Security, Retirement, Health Insurance subaccounts between 4900 and 4999. 
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Fund: Unique grouping of budget(s) segregated for specific purposes, costing and 

revenue support.  

Fund Code:  6 digit number indicating the particular fund, i.e., 011001 = E&G 

Ledger: Large grouping  of budget codes/fund codes that generally reflect the “color of 

money”. 

Net: Revenues minus expenses. 

NPS: Budget category rollup of nonpersonal service line items such as skilled services, 

utilities, etc. subaccounts between  5000 and 6999. 

Organization Code: same as Budget Code.  

Personnel: Budget category rollup of Personnel line items such as classified salaries, 

wages, GTA’s, etc. subaccounts between  4000 and 4799. 

Revenue: Budget category rollup of Revenue line items such as tuition, lab fees, health 

fees, athletic event fee subaccounts between  3000 and 3999. 

Sub-Account:  4 unique digit code for each itemized revenue or expenditure or transfer 

line-item.  

Sub-Account Description: A description of the sub-account line-item category, 

generally including what it consists of (tuition for a specific item, fees for a specific item, 

GTA’s, etc.).  

Transfers: Budget category rollup of Transfer line items such as transfers to 

scholarships, transfer to auxiliary subaccounts between Accounts that are between 

9900 and 9949. The act of moving money from one fund to another. Fund transfers are 

accounting transactions that move cash from one fund to another and are classified as 

mandatory (arising from binding legal agreements) and non-mandatory (agency 

discretion). 

Travel: Budget category rollup of Travel line items  subaccounts  between 7000 and 

7999. 

YTD: Abbreviation for Year-To-Date activity.
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Directory Layout 

Base Budgets: 

 1: CBB by VP Area 

 2: CBB by VP Area by Revenue/Expenditure Category 

3: CBB by VP Area by Revenue/Expenditure Category by Subaccounts 

 4: CBB by Budget Code by Revenue/Expenditure Category Rollups 

 5: CBB by Budget Code by Revenue/Expenditure Category by Subaccounts 

 6: CBB by Budget Code by Revenue/Expenditure Category Across by Subaccounts 

(w/Divisional Subtotals & Totals) 

 7: Base Budget Trends Report 

Current Budget Reports: 

 1: COB by Revenue Expenditure Category Rollups 

 2: COB by Revenue/Expense/Transfers 

 3: COB by Revenue/Expense/Transfers by Subaccount 

 4: Current Operating Budgets by College/Division by Budget Report 

 5: Current Operating Budgets by College/Division Report 

 6: Current Operating Budgets by College/Division with Subaccount Detail & Composite 

Report 

 7: Current Operating Budget Revenue Report 

 8: YTD Ledger Rollup Report 

Fund Code/Auxiliary: 

 1: Fund Code by Current Operating Budgets Report 

 2: Auxiliary Fund Rollup Report Budget 

Current Budget Balances: 

 1: Negative Budget Balances Report by VP Area 

 2: Negative Budget Balances Report by Budget Code/Hierarchy 

Transactions/Subaccounts: 

 1: Subaccount(s) Specific Report 

 2: Budget Transactions Matrix Report  

Budget Trends: 

 1: Operating Budget Revenue Trends Report 

 2: Operating Budget Trends Report 

 3: Revenue Expenditure Net Trends Report 
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Budget Report Names, Purposes, Prompt Screens, Sample Output Reports 

 CBB by Budget Code by Revenue/Expenditure Category Rollups 

Purpose: This report provides the most current (active base budget) typically used to evaluate 

permanent budget actions and to plan for next year’s operating budget. Displays current base budget 

(based on organizational hierarchy and your access) by total revenue and Expense Categories, 

Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers. Allows drilldown to Budget Units. 
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 CBB by Budget Code by Revenue/Expenditure Category by Subaccounts 

Purpose: This report provides the most current (active base budget) typically used to evaluate 

permanent budget actions and to plan for next year’s operating budget. Displays current base budget by 

Revenue and Expense Categories by Subaccounts. 
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 CBB by VP Area 

Purpose: This report provides the most current (active base budget) typically used to evaluate 

permanent budget actions and to plan for next year’s operating budget. Displays current base budget by 

VP Area by College Division by Total Revenue and Expense/Transfers. Allows drilldown by Division to 

Budget Units. 
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 CBB by VP Area by Revenue/Expenditure Category 

Purpose: This report provides the most current (active base budget) typically used to evaluate 

permanent budget actions and to plan for next year’s operating budget. Displays current base budget by 

VP Area by College Division by Total Revenue, Expenditure Categories and Expense/Transfer Total. 

Allows drilldown by Division to Budget Units. 
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 CBB by Budget Code by Revenue/Expenditure Category by Subaccounts 

Purpose: This report provides the most current (active base budget) typically used to evaluate 

permanent budget actions and to plan for next year’s operating budget. Displays current base budget by 

Revenue and Expense Categories by Subaccounts. 
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CBB by Revenue/Expenditure Category Across by Subaccounts(w Divisional Subtotals & Totals) 

Purpose: This report provides the current (active base budget) typically used to evaluate permanent 

budget actions and to plan for next year’s operating budget. Displays current base budget by Revenue 

and Expense Categories across and details by Subaccounts. Utilizes multiple parameters and enables 

divisional and budget categorical subtotals and totals of data.  
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COB by Budget by Revenue/Expense/Transfers (FGIBDST) 

Purpose:  This report provides the most current (operating budget activity report) typically used to 

evaluate year-to-date activity, encumbrances, and balances and to manage available resources 

accordingly. Rolls up to revenue, expense/transfers. Allows drilldown to COB by Revenue/Expenditure 

Category Rollups or Revenue/Expenditure/Transfer Category by Subaccounts. 
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COB by Budget by Revenue/Expense/Transfers by Subaccount (FGIBDST) 

Purpose: This report provides the most current (operating budget activity report) typically used to 

evaluate year-to-date activity, encumbrances, and balances and to manage available resources 

accordingly. Displays data by budget categories: Personnel, Fringes, NPS, Travel, Equipment, Transfers, 

and then by Subaccounts. 
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 Current Operating Budget Revenue Report (FGIBDST) 

Purpose: This report provides the most current (operating budget REVENUE activity report) typically 

used to evaluate year-to-date revenue collected/deposited, and balances to attain budgeted revenues. 
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Fund Code by Current Operating Budgets Report 

Purpose: This report provides the most current (operating budget activity report) typically used to 

evaluate revenue and expense year-to-date activity, encumbrances, and balances and to manage 

available resources accordingly. Details adopted budget, adjustments, current budget, YTD, 

encumbrances, remaining balances by budget category rollups and net. 
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Auxiliary Fund Rollup Report 

Purpose: This report captures all Auxiliaries within one's hierarchy and provides the high level current 

budget by budget category rollups and net. Allows drilldown to the Fund Code by Current Operating 

Budgets Report. 

 

 
 



 BUDGET MANAGEMENT AND FINANCIAL REPORTING  
 

  
 
Part of the Certificate in University Financial Management – revised October 25, 2016  Page 82 

 Negative Budget Balances Report (FGIBAVL) - by Budget Code/Hierarchy 

 

Purpose: This report provides the most current (operating budget activity report) typically used to 

evaluate year-to-date activity, encumbrances, and balances and to realign one’s budget to eliminate 

negative balances in controlled subaccounts (4000 series) vs. pool accounts (NPS, Travel, Equipment). 
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Negative Budget Balances Report (FGIBAVL) - by VP Area 

 

Purpose: This report provides the most current (operating budget activity report) typically used to 

evaluate year-to-date activity, encumbrances, and balances and to realign one’s budget to eliminate 

negative balances in controlled subaccounts (4000 series) vs. pool accounts (NPS, Travel, Equipment). 
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Subaccount(s) Specific Report (FGIBDST) 

Purpose: This report enables subaccount specific inquiries from the operating budget to examine 

discreet data needs. For instance, you may need to examine subaccounts 4022 and 4023 over the last 

five years. This report with the right combination of parameters satisfies such inquiries. This report, 

when using multiple fiscal years, is best exported to Excel where the data columns can be 

managed/hidden as needed. 
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Budget Transactions Matrix Report (FGITRND) 

 

Purpose: This report enables a top to bottom accounting of all transactions occurring in a specific budget 

unit from budget load to budget adjustments to expenditures and encumbrances. Total Reconciliation 

Trail. 
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YTD Ledger Rollup Report (FBIBDST) 

 

Purpose:  This high level Operating Ledger report provides the operating budget activity report grouped 

by Ledgers 1 to 8 +++ typically used to evaluate revenue and expense year-to-date activity, 

encumbrances, and balances and to manage available resources accordingly. 
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Current Operating Budget (COB) By College/Division Report (FGIBDST)  

 

Purpose: This VP Level report enables high level summaries of college/division budgets typically used to 

compare Original Budget, Current Budget, Year-To-Date activity, Encumbrances, and Balances and to 

manage available resources accordingly. Rolls up subaccount data to budget categories: Revenue, 

Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, Debt Service, Total Expense, and Net. Has 

functional drilldowns to Budget Unit data. 
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Current Operating Budget Report (COB) by College/Division by Budget Report (FGIBDST)  

 

Purpose: This VP Level report can be accessed directly or is a drilldown from the COB by College/Division 

Report. Enables budget level typically used to compare Original Budget, Current Budget, Year-To-Date 

activity, Encumbrances, and Balances and to manage available resources accordingly. Rolls up subaccount 

data to budget categories: Revenue, Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, Debt 

Service, Total Expense, and Net. 
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(COB) BY COLLEGE/DIVISION SUBACCOUNT DETAIL & COMPOSITE REPORT (FGIBDST)  

 

Purpose: This report enables detailed budget unit reports by college/division comparing Original Budget, 

Current Budget, Year-To-Date activity, Encumbrances, and Balances by budget by subaccount level and 

budget categories: Revenue, Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, Debt Service. Also 

Recaps Ledger/Color of Money composite. All components can be downloaded to Excel enabling budget unit 

specific reports which can be supplemented with your fiscal year projections and aggregated for Divisional 

Reports. 
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My Budget List   

 

Purpose: Simply run this report and you will be shown your userid, user name, and the fund codes and 

budget codes you have access to.  
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Base Budget Trends Report 

Purpose: This report provides comparative base budget data over multiple fiscal years. 
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 Operating Budget Revenue Trends Report (FBIBDST) 

 

Purpose: This report enables the tracking of operating budget revenue trends data typically used to 

evaluate multiple fiscal years of budgeted to actual revenue collected/deposited. This report, when 

using multiple fiscal years, is best exported to Excel where the data columns can be managed/hidden as 

needed. 
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Operating Budget Trends Report (FGIBDST) 

 

Purpose:  This report enables the tracking of operating budget trends data typically used to evaluate 

multiple fiscal years of budgeted to actual expense. Displays data by budget categories: Personnel, 

Fringes, NPS, Travel, Equipment, Transfers, and then by Budget, YTD by Fiscal Year. 
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Revenue Expenditure Net Trend Report 

 

Purpose: This report enables the tracking of operating budget Revenue and Expenditure/Transfer trends 

data typically used to evaluate multiple fiscal years of budgeted to actual activity. 

 

 
 



 BUDGET MANAGEMENT AND FINANCIAL REPORTING  
 

  
 
Part of the Certificate in University Financial Management – revised October 25, 2016  Page 96 

 



 BUDGET MANAGEMENT AND FINANCIAL REPORTING  
 

  
 
Part of the Certificate in University Financial Management – revised October 25, 2016  Page 97 

E&G Year End Budget Trends by FY by College/Division 

 

Purpose: This report enables a review of actual E&G expenditures by fiscal year trends determined by 

the user. Consistent with organizational hierarchy and Banner security access level, data can be rolled 

up to the college/division level and drilled down to the department level. For Academic Affairs year-end 

program reviews the data can display the personnel subaccount details while rolling up the fringe 

benefit, NPS, travel, and equipment categories. 
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Subaccount Detail and Composite Report 

 

Purpose:  This report enables detailed budget unit reports by college/division comparing Original 

Budget, Current Budget, Year-To-Date activity, Encumbrances, and Balances by budget by subaccount 

level and budget categories: Revenue, Personnel, Fringe Benefits, NPS, Travel, Equipment, Transfers, 

Debt Service for multiple fiscal years and multiple budgets. Also Recaps Ledger/Color of Money 

composite. All components can be downloaded to Excel enabling budget unit specific reports which can 

be supplemented with your fiscal year projections and aggregated for Divisional Reports. 
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Purpose: List of Reports That Access Other Reports 

 
1. CBB by Budget Code by Revenue/Expenditure Category Rollups 

a. CBB by Budget Code by Revenue/Expenditure Category by Subaccounts 

 
2. CBB by VP Area 

a. CBB by VP Area by Revenue/Expenditure Category 

i. CBB by VP Area by Revenue/Expenditure Category by Subaccounts 

 
3. Fund Code by Current Operating Budget 

a. COB by Budget by Revenue/Expense/Transfers (FGIBDST) 

b. COB by Budget by Revenue/Expense/Transfers by Subaccount  

 
4. Auxiliary Fund Rollup  

a. Fund Code by Current Operating Budget  

 
5. Current Operating Budget (COB) By College/Division Report (FGIBDST)  

a.  Current Operating Budget (COB) By College/Division by Budget Report (FGIBDST) 
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6. Activating Insight and Operational Data Store Services for Budget Report Access 

 

1. Login to MIDAS at http://midas.odu.edu.  

2. Review your Active Services under Account Details.  

a. Services Insight and Operational Data Store (ODS) must be under your Active Services 

to be able to access Budget Reports.  

 

 
 

b. If you do not see these under your Active Services, click on the Inactive Services tab. 

Locate the Insight and/or Operational Data Store (ODS) options and click on one. 

c. Click on the button “Click to Activate Service”. 

d. Verify you receive the message “Service successfully activated”. 

e. Click the link “Back to Account Information”. 

f. Verify that the service you selected is in your Active Services list. 

g. Perform actions b through f to add the other service you may not have.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://midas.odu.edu/


 BUDGET MANAGEMENT AND FINANCIAL REPORTING  
 

  
 
Part of the Certificate in University Financial Management – revised October 25, 2016  Page 103 

 
 
 

 How To Modify Internet Explorer Options to allow Excel formatted 
output. 
 

7. Open Internet Explorer 

8. Click on Tools -> Internet Options 

9. Click on Security tab 

10. Click on Internet  

11. Click on Custom Level 

12. Ensure that the Automatic Prompting for File Downloads and File Download are enabled. 

13. Click OK 

14. Repeat the same for Intranet and Trusted Sites options as well. 

15. Close the browser and run the report. 

16. You may need to allow popups from this website.  To do this, go to Tools -> Pop-up Blocker -> 

Pop-up Blocker Settings. In the box labeled Address of website to allow: input insight.odu.edu. 

Click the Add button on the right hand side of the box, and then click Close. 
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How To Output Information in PDF, Excel 2002 and 2007 versions. If you 

have Excel 2010, it will open if you select the 2007 version. 

 
Once a report has been run, and you are able to view output, you can click on the Output button’s drop 

down arrow in the top right hand corner.  

 

 
  

A menu will appear, allowing you choices of how you would like to view the output. 

 

 
 

Clicking on “View in PDF Format” will output the same data you see in a PDF file.  
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Clicking on the “View in Excel Options” provides a drop down allowing you to choose various Excel 

format options. Click the one that you would like to view. 

 

 
 

Click the one that you would like to view. A pop up will appear. You have the option to save or view.  
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Clicking on “Open” reveals the data in an Excel spreadsheet. 

 

 
 

Clicking on “Save” will display another pop up, asking you for the filename and directory where you 

would like to save the file. 
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 BUDGET MANAGEMENT AND FINANCIAL REPORTING  
 

  
 
Part of the Certificate in University Financial Management – revised October 25, 2016  Page 108 

Methods to Add a Budget Tab to Your Account 
 

Method One 

1. Click the area button  towards the left hand corner and click on My Preferences 

menu item, and then click the Portal Tabs tab. A list of your current tabs appears.  
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2. Click Add. 
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3. In the list of available pages, select the page you want. You can select multiple 

pages. Click Public Folders. 
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4. Click Access Pages. 

 

 
 

5. Click Budget Tracking. Click the right arrow button  to move the page to the 

Selected entries box. 

 
 

6. Click OK. The tab for the page appears in the portal. 
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7. Click Ok. The Budget Tracking tab appears on your menu. 
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Method Two 

1. From the tab menu  on the left side of the tab bar, click Add tabs. 
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2. In the list of available pages, select the page you want. You can select multiple 

pages. We will select Public Folders.  
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3. Select Access Pages.  

 

4. Click Budget Tracking. Click the right arrow button  to move the page to the 

Selected entries box. 
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5. Click OK. The tab for the page appears in the portal. 

 

6. Click Ok. The Budget Tracking tab appears on your menu. 
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 BUDGET MANAGEMENT AND FINANCIAL REPORTING  
 

  
 
Part of the Certificate in University Financial Management – revised October 25, 2016  Page 118 

Informational Notices 

 

If you receive the following screen(s), this means you do not have the access for the prompt choices 

made or no data exists for that combination. 
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                                     Data Control, Office of 

Finance 

______________________________________________ 

 

 

 

Printing Financial Reports 

(Budget and Payroll Month-End) 

via ePrint 

 

TRAINING REQUIRED BEFORE ACCESS IS 

GRANTED 
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What is Banner ePrint? 

 

The Office of Finance has not provided monthly budget reports to the vast majority of departments 

since the implementation of Banner in 1998.   Banner ePrint allows users to print monthly budget 

reports as soon as they are available – usually the first business day of the month.  It also replaces the 

distribution of hard-copy reports for departments with a large number of budgets.  Please ensure that 

you see the message indicating that budget reports have been validated before using any budget 

reports via ePrint.   

 

Employees who monitor and report on budget and payroll activity can obtain access to ePrint.  However, 

before the access is granted, all users must attend Office of Finance ePrint training. 

 

ePrint allows a user to view reports as a PDF (Adobe Portable Document Format) file which can be 

viewed via Adobe Reader or to download a CSV file into Excel.  Keep in mind that when you download a 

CSV file, you must format the size of the columns to display all information.   

 

ePrint users will be notified via Repository Messages/Notifications when reports are available and 

validated.  If reports are delayed, a message concerning the delay will be posted in the Repository 

Messages/Notifications. 

 

What is a Repository?  A simple way to define a repository is to think of it as a silo of information.  

Initially, there is only one repository in ePrint – FINANCE eprint AIR.  This repository houses the financial 

reports currently loaded in ePrint.  Eventually, there will be other repositories – i.e. Human Resources, 

Student.  Several Finance reports and the month-end payroll detail reports, NHRSDST and NWRSDST, are 

currently loaded to this repository. 
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What Do You Need to Get Started? 

 
 

 Banner System Account (with appropriate access) 
 

 Current Web Browser 

Microsoft® Internet Explorer * (Preferred) 
Mozilla ® Firefox 
Opera Software ® Opera 
Apple ® Safari 
 Chrome 
 

 Adobe®Reader 
Download the latest version from www.adobe.com 

Run within your browser or in stand-alone mode (recommended) 
 

 

Banner System Account: Since ODU uses security to control access to at least some of the ePrint 

reports, you’ll need a Banner system account (user ID and password).  Contact the Banner Hotline 

(bannerhotline@odu.edu) for more information. 

 

REMINDER REGARDING PAYROLL REPORTS - Access to departmental Payroll ePrint Reports must be 

requested separately.  To obtain access to Payroll ePrint reports, the Office of Finance ePrint Payroll 

Report Request Form must be completed and submitted to Data Control, Office of Finance (requires 

approval of the Budget Unit Director). 

 

http://www.odu.edu/content/dam/odu/offices/finance-office/data/payroll-eprint-request.pdf  

 
 
Web Browser: Banner ePrint was designed to run on the newer web browsers.  It is recommended 

that you use the latest released version of your current browser. 
 
Adobe® Reader:  This helper application enables you to view, navigate and print documents in the 

Adobe® Portable Document Format (PDF).  You probably already have it installed on your computer.  

If not, you can get the latest version for free at www.adobe.com. 
 
When you view and print ePrint documents, you can run Adobe® Reader within your browser, or as 

a stand-alone application.  The mode of operation that you select may depend on the browser you 

use.  

 

Because of some display problems, if you use Microsoft® Internet Explorer, you may wish to run 

Adobe® Reader independently of the browser. 

 

http://www.adobe.com/
mailto:bannerhotline@odu.edu
http://www.odu.edu/content/dam/odu/offices/finance-office/data/payroll-eprint-request.pdf
http://www.adobe.com/
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 BUDGET MANAGEMENT AND FINANCIAL REPORTING  
 

  
 
Part of the Certificate in University Financial Management – revised October 25, 2016  Page 124 

 

How Do You Access ePrint? 

ePrint is accessed through the web from the link shown below.  You will use your MIDAS  User ID and 

MIDAS password to log into ePrint.  You will also need to select the appropriate repository.  A 

repository is equivalent to access type and what a user has access to print is tied specifically to the 

user’s Banner access.  For Budget and Payroll reports, specify “FINANCE eprint AIR” under Repository.  

Once you enter your User ID, password and repository, press ENTER. 

Type carefully – your account will be locked if you repeatedly attempt to log in with the wrong 

password.  If this happens, a system message will be displayed – contact ITS at 757-683-3192 to have 

your ePrint account unlocked.  Also be sure to verify that you are using the correct repository.  If you 

are trying to log into the wrong repository, you may end up locking your ePrint account.  

 https://gutenberg.imgr.odu.edu/cgi-bin/eprint.cgi 

 

 

https://gutenberg.imgr.odu.edu/cgi-bin/eprint.cgi
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Repository Messages/Notifications 

You will see the message “Repository Message is Available” when you log in.  Simply click on the 

Repository Message is Available link to view the information (allow the message a moment to load).  

You will also see the date of the last message.  Please review this information whenever you log in since 

it is the way we will notify you when new reports are available and verified, and when reports may be 

delayed.  If the message displays on a tab in your browser, be very careful not to close your browser.  

Most times the message will display as shown in the second screenshot. 
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When You First Log In 

When you first log into ePrint, you will see all the reports available in the selected repository for you to 
print via ePrint – the budget reports currently available in the FINANCE eprint AIR repository are 
FGRBDSC and FGRODTA; and the Payroll detail reports, NHRSDST and NWRSDST, are also loaded.  For 
each report shown, you will see the report type, the report name, description and the latest date and 
time the report was run (you are able to access older reports by drilling down – discussed later).   Keep 
in mind that you will only see the reports to which you have access.  If you have created groups using 
the My ePrint function (more information later), then the group tabs will also be displayed.    You can do 
one of the following by clicking the appropriate icon: 

 Retrieve the latest report in its entirety in PDF format – has navigation choices for orgs on left 

 Download the latest report as a text file in its entirety – no navigation choices – must scroll 

 Download the latest report as a comma-separated values (CSV) file – into Excel 

 List all the reports of a given type (by report type or latest date) 

FGRBDSC, Budget Status Report, similar to FGIBDST (Organization Budget Status Form) – this report 

shows the summary information for a budget by sub-account and by the following totals: 

Labor (all salary sub-accounts – no pay details display – details in payroll reports)  
Employee Benefits (4999 pool) 
Non-Personal Services (6999 pool) 
Travel (7999 pool) 
Equipment (9899 pool) 
Transfers 
TOTAL ORGANIZATION  (roll-up similar to FGIBSUM) 
 
FGRODTA, Organizational Detail Activity – similar to FGITRND (Detail Transaction Activity Form) – 

shows activity by sub-account (payroll details display totals by pay period – no details by employee 

name). 

NOTE FOR ALL REPORTS: At this level you see the most recent report posted – older reports are available 

in descending date order by drilling down. 
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NHRSDST, Employee Payroll Summary by Org. – shows payroll activity for each part-time payee by 
budget code. 

NWRSDST, Employee Payroll Summary by Org. – shows payroll activity for each full-time payee by 

budget code. 

REMINDER REGARDING PAYROLL REPORTS - Access to departmental Payroll Reports must be requested 

separately.  To obtain access to Payroll ePrint reports, the Office of Finance EPrint Payroll Report 

Request Form must be completed - requires approval of the Budget Unit Director(BUD).   

http://www.odu.edu/content/dam/odu/offices/finance-office/data/payroll-eprint-request.pdf  

(NOTE:  when reviewing payroll reports, drill down by clicking on the drill icon rather than the 
PDF icon – this will allow you to choose a sub-account to review – use NEXT to see more reports.) 
 

 

 

http://www.odu.edu/content/dam/odu/offices/finance-office/data/payroll-eprint-request.pdf
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Use the Icons as a Guide 

Banner ePrint’s icons make it easy for you. At any level, click the corresponding icon to perform a 
function. If a function is not available, the icon will not be displayed. If you forget an icon’s function, 
you can display a brief description by moving your cursor over the icon so that you can see bubble 
help pop up. 
 
Use the back browser arrow for navigation purposes. 
 
Simply point-and-click to . . . retrieve a PDF file, download to TXT, download to CSV into an 

Excel file, drill down, or use a page key to pick pages/search report.   

   

   Retrieve a PDF file to view in Adobe®Reader 

 

 
 
To retrieve the report in PDF, click the PDF icon. Depending on the way you have Adobe® Reader 
configured, the report will open within your browser or in stand-alone mode.  For best 

performance, open Adobe®Reader outside of the browser.  Technical assistance is provided by 
your TSP (technical support person) via Footprints.  (NOTE:  when reviewing payroll reports, you 
will want to drill down by clicking on the drill icon rather than the PDF icon – this will allow you 
to choose a sub-account to review – use NEXT to see more reports.) 
 
When you retrieve the PDF file, you will see all the budgets to which you have access displayed in 
the left hand pane.  Clicking the expand/collapse symbol (plus or minus sign) next to the budget 
code will display the fund code associated with that budget.  Clicking the budget code will take you 
to that specific budget report. 

 
Use your back browser arrow to return to the Report list shown above. 
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Download the TXT version of a report 

 

 
 

Click the Text icon to download the text version of a report.   When you see the message below, 
click ok to display the report in the browser – you will be able see all budgets to which you have 
access beginning with the first budget.  You will need to use the scroll bar.  If you have multiple 
budgets and wish to display one at a time (or in specified groups), this is not the way to do so 
(refer to the section entitled Search Report Icon and Picking Pages).  Use the back browser arrow 
to return to the menu shown above. 
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  Download the CSV version of a report (into Excel) 
 
This feature is not currently available for Payroll NHRSDST/NWRSDST reports. 

 
 
Click the Data icon to download the comma-separated values version of a report.   
 
When you see the message below, click ok to display the report in the browser – click ok and 
you will see the file download dialog box.  You can choose to Open, Save, or Cancel.  If using 
Internet Explorer, you may use the alternate (right) mouse button to see a menu and select “Save 
Target As” for a quicker way to save the file. Opening the file may take a while. 
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If you Open the file (remember it opens as a standard CVS file), the report name and run date display.  

Note that you will need to format the columns.  When you see #### display in columns, that means 

the columns are not wide enough for the data contained. 

 

If you select Save the file, you will see the Save As dialog box – choose where you want to save your 

file and use the default file name or choose one of your own – you will then be able to retrieve the file 

and format the columns as noted above: 
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 “Drill down” for detail (See Report List) 
 

 
 
 
The See Report List icon enables you to “drill down” from the repository list to a specific report list.  
A report list shows all the available reports in date order for the selected report type.  This is the 
recommended method for viewing payroll reports, as noted earlier.  Using the “drill down” feature 
takes you to all reports in descending date order. 
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   Use a page key to pick pages  

  (Search Report) 
 
 

 

Search Report Icon and Picking Pages (customizing budget searches) 

When you see the Search Report icon (magnifying glass in the screenshot below), it means you have 

reports for more than one budget and/or fund.   A Page Key is either a Fund or Organization.  You will 

need to “pick” which you want to display.  Click the Search Report icon to “pick pages.”   This will allow 

you to select the funds or budgets to appear on the report.  If you have access to multiple budgets, you 

may wish to select which budget codes you want to display.  Otherwise, ALL budgets included in your 

access will display.   

If you have multiple budgets/funds, you will want to save your searches so that you do not have to 

perform a search each time you wish to view individual budget reports.  Saving your searches will 

allow you to display budget reports in ways that are most useful to your department.  (If you use your 

back browser arrow when starting a new search, be sure to uncheck your choices or those choices will 

be included in the new search.) 

 

After you Click the Search Report icon, you will be taken to Pick Pages for the report selected 
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 Choose either Fund or Organization under Page Key – be sure you are selecting the correct 

description.   

 If you want to choose  from a list of funds or organizations, under“Pick Values Manually” click 

Go.  

 

You will now be able to Choose Organizations from the budgets to which you have access.  If you have 

access to more budgets than can display on this screen, you will see the Next button in the lower right 

corner of your screen.  If you wish to go to a specific budget or fund, enter the budget or fund in the 

field next to the word “go” and click Go.  Select the budgets you want to display.  Then you can click on 

Get the Report (see next page.) 

You may choose multiple budgets or a range of budgets when creating your search.  Saving your 

search will allow you to access those budget(s) whenever you wish to view budget information 

without having to choose budgets each time (see next page for info on saving a search). 
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The budgets you selected will now be displayed and you can choose a report format (PDF, Text, Data).  

You also have the option of saving your search criteria using a name of your choosing.  Then, every time 

you wish to access reports for those funds or organizations, you can run this search.  Using a saved 

search is especially useful if you have access to budget information for multiple funds or budgets.    

If you do not save your search criteria, you will always have to scroll through the full report to find an 

individual budget.  These saved searches apply to currently available reports as well as future reports.   

Choose a name for your search and Save it.  You may not use the same name again.  Define a distinct 

name for each search.  (Remember that you will need to define your searches for each type of report 

available – ie FGRBDSC/FGRODTA/NHRSDST.) 

 

 

If you have successfully saved your search, you will see the following message.  This means you will be 

able to use this search when reviewing your reports.   

At this point, you can access your reports (discussed earlier) in the format of your choice. 

Use the back browser arrow to navigate backwards. 
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USING A SAVED SEARCH 

 

All saved searches (Organization or Fund, depending on which Page Key you have selected) will display 

via the drop-down under Saved Searches.  Select the search you want to access and click Go.  You may 

also delete searches. 

 

 

In the example below, a range of budgets was selected and you can now access the report in the 

format of your choice. 
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Pick Page by Range 

 If you want to display a range of budgets – or only one – fill in the range and click Go.  Be sure that your 

range is sequential.   Make sure you use UPPER CASE when entering a a budget code range, otherwise, 

you will see all your budgets and not just the ones contained in the range entered. 

 

Your range of budgets or funds will display and you will be able to select a report format.  Remember, 

you will only see budgets/funds to which you have access.  You also have the option of saving your 

search criteria using a name of your choosing.  Then, every time you wish to access reports for those 

funds or organizations, you can run this search. 

If you do not save your search criteria, you will always have to scroll through the full report to find an 

individual budget.  These saved searches apply to currently available reports as well as future reports.   

Choose a name for your search and Save it.  You may not use the same name again.  Define a distinct 

name for each search.   (Remember that you will need to define your searches for each type of report 

available – ie FGRBDSC/FGRODTA/NHRSDST.) 
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If you have successfully saved your search, you will see the following message. 

 

 

You will then select how you want your report to display (icon usage discussed previously). 

PDF – displays in your browser - in the left tab, you will see a list of all funds or organizations for the 
range you selected. 

Text – displays in your browser – no tabs will display and you will need to scroll to view.  

Data – allows download to Excel – you will always see the file download message and will be prompted 
to open or save your file – not available for Payroll reports, NHRSDST/NWRSDST. 
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Customizing Your Reports 

You can customize your reports to make them more useful by using My ePrint.  Click on My ePrint to 
begin customization.  If you have access to multiple repositories, you must customize the reports in each 
repository. 

 

 

Once you click My ePrint, you will see the information below.   You will see Available reports on the left 

and Selected reports on the right.  (Your available reports will differ from the screenshot below.)  

Initially, the information in Selected reports will be blank.  The Available reports will display the reports 

available in the selected repository.  Click on the Create Group tab to begin customizing. 
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Using My ePrint allows you to separate the actual reports into separate groups – i.e., Budget Status 

Report, Organizational Detail Activity, or Payroll Detail Report. 

 Enter the Group name (this is where you determine how you want your info to display) – in 

the screenshot below, we are naming the group Budget Status 

 Highlight the report you wish to put in the group 

 Click the Add reports to this group button (right pointing arrow).  This will put the report you 

selected under Selected reports.   

 

 

Once the report is moved into Selected reports, you can Save your group. 
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If successful, you will see the message indicating you have successfully added the group.  You will also 

note that the available reports now displays the original default list and you will be able to create other 

groups using that report.   If you attempt to use the same name again, you will see a message “Duplicate 

Name: Group ‘XXXX’ already exists, please use a unique name.” 
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If you have set up multiple groups in a repository, you can make a group the default when you log in to 

ePrint by checking the Default login group check box and clicking Save. 

 

If you have successfully set your default login group, you will see the following message. 
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User Change Repository Function 

When you log into the repository, you will see your group tabs with the default login group 

highlighted.    You can change your repository by selecting Change Repository. 

 

If you attempt to move to a repository where there are no reports for you to view, you will 

receive the message “There are no reports for you to view in this repository.” 
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NAVIGATION BAR 

The navigation bar appears near the top of each ePrint page and displays your current location within 

the system.  Its sections are separated by colons.  Click within a section to return to that system page.   

Using the navigation bar is more specific than using the back browser arrow since you can select a 

particular page instead of having to link backwards one by one through all the pages you have accessed. 
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Remember to Use ePrint Help! 
 

 Every page (even login page) has link to 
context-sensitive Help. 

 

 Every Help page has link to: 
 

Contents Page  

Alphabetized Index  

Related Topics 
 
 

 

 

Help is never more than a click or two away in Banner ePrint, so use the Help pages when 

you have questions! There is a link just below the title bar on each ePrint page. This link will 

open a context-sensitive topic with information on that particular part of the system. 
 

In addition, each ePrint Help page provides links to other pages. Near the top of each page, 

you’ll find a link to the Help’s table of contents and index. Near the bottom of applicable 

pages, you’ll find links to related topics. There are additional references to related material 

within most of the Help pages; follow the links. 

 

If your questions are not answered, please send an e-mail to bannerhotline@odu.edu.  

 

 

 
 

 
 

 
 

 
 

 
 

mailto:bannerhotline@odu.edu
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FREQUENTLY ASKED QUESTIONS 
 

Do you have questions about something about ePrint?  Select FAQ 
(Frequently Asked Questions). 

 

 

 
 
 
 
 

 
 

 
 

 
  

 

 
 



 BUDGET MANAGEMENT AND FINANCIAL REPORTING  
 

  
 
Part of the Certificate in University Financial Management – revised October 25, 2016  Page 148 

 

Select Topic and click link 

 

 

When you click the FAQ link, you will be directed to the User FAQ page.  The Table of 

Contents has the major topics of information.  Click the topic link to see more information. 
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LOGGING OUT IS IMPORTANT 

For security reasons, you should log out of Banner ePrint if your browser will remain open and you will 

be leaving your computer unattended. 

 

 

Note that the Logout link does not appear in your browser when you are viewing a PDF document (if 

Adobe®Reader is configured to run within the browser).   

 

In order to log out after viewing a PDF document, you must first click the back arrow in your browser to 

return to an ePrint report selection page.  Then you can click the Logout link. 

 

CONTACT INFORMATION  

Please direct questions about using ePrint to bannerhotline@odu.edu.   
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